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Chapter 1 
Introducing the Program 

One of Brentmark’s most popular programs, Pension and Roth IRA Analyzer is used and 
recommended by pension distribution planning experts. 

 
Pension Distribution Planning 
While the program is the most comprehensive available for pension distribution planning, 
you will find running the program straightforward and simple. The key is to think of the 
main window as divided into parts.  
 
The program evaluates various strategies of taking distributions from qualified plans, 
traditional IRAs and Roth IRAs. It calculates up to four alternatives simultaneously. It’s 
designed to handle both the current (2003 and later) rules and all recalculation options for 
the old rules.  
 
The program also includes income tax and estate tax calculations for you. You can model 
spousal rollovers and account for the §691(c) deduction for estate tax. It will also show 
you the value of the stretchout in the hands of the beneficiary. 
 
Roth IRA Conversion Analysis 
If you’re looking to do Roth IRA conversion analysis, Pension & Roth IRA Analyzer is 
the most comprehensive program available. It handles partial and multiple year 
conversions. It also performs optimization conversion calculations based on Net After-
Tax Assets and handles estate tax and income tax.  
 
Distribution Planning  
You can see the effect of all three methods under IRS Rev. Rul 2002-62 (2002 and later) 
and IRS Notice 89-25 (2002 and earlier) that may be used to avoid the 10% penalty on 
early plan distributions. You can select different life expectancy tables and reasonable 
interest rates.  
 
Other Program Features 
You can: 

• Toggle inflation adjustment on or off.  

• Enter distributions pre-tax or after-tax.  

• Handle income tax by entering rates or entering AGI. 

• Send to your printer, a text file, a spreadsheet file or the clipboard. 

• Use the report designer for custom reports. 
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The program also includes donee exclusion gifting, 2nd-to-die insurance proceeds and 
premiums, and presentation-style graphs.  

 
The first step to using the software is to install it on your computer, using the instructions 
that follow. 

Installation 
Before you install the program, be sure that you’re running a Windows 95 or later 
operating system. The Pension & Roth IRA Analyzer does not run on Windows 3.1 or 
earlier operating systems. 

Installing the Program 
Insert the disk into the disk drive. 

On the Windows Taskbar, click the Start button. 

On the Start menu, click Run. The Run dialog box appears. In the Open box, 
A:\setup.EXE should appear. If it doesn’t, type A:\setup.EXE. 

Click OK. 

The setup program begins. Follow the instructions in the setup program. 

Uninstalling the Program 
On the Windows Taskbar, click the Start button. 

Point to Settings and click Control Panel. The Control Panel window appears. 

Click Add/Remove Programs. The Add/Remove Program Properties dialog box 
appears. 

Use the scrollbar to find the Minimum Distributions Calculator. When you find it, click 
the program title. Notice that the Add/Remove button is now functional. 

Click the Add/Remove button. 

The uninstall program begins. Follow the instruction in the uninstall program. 
  

What Do You See on the Screen? 
When you run the program, the Pension & Roth IRA Analyzer window opens. The rest of 
this chapter will be devoted to the interface—what you see on the screen and how to go 
through the program step by step. 
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These are the things you’ll see on the screen: 

Title Bar 
The title bar is the blue bar that appears in the top of the window. It contains the 
following information: 

• Program title 

• Program version number 

• File name (if the file has been saved) 

Menu Bar 
The Menu bar appears below the title bar. Use the Menu bar to select program 
commands.  

 

Toolbar 
The toolbar, located below the Menu bar, contains graphics as commands. You can click 
these graphics instead of using the related Menu bar commands. 
  

Open Files. 

Save Files. 
Print Files. 

Open Quick Conversion.

View Reports.

Get Help.



Chapter 1:  Introducing the Program 

 4 

Current Report

Buttons to 
display 
different 
data entry 
sections 
              

OK, now onto looking at the window.  

 

 

Right Side of the Window: Data Entry Sections 
The right side of the window displays the program’s data entry sections.  
 

Left Side of the Window: Buttons to Get to Different Data Entry Sections 
Click the buttons on the left side of the window to display different data entry sections. 
When you click a button, the button title appears red. For example, when you open the 
program or create a new file, the title of the first button in the column, Main Inputs, is 
highlighted in red.  

Bottom Portion of the Window: Current Report 
The bottom portion of the window displays report results. Throughout this manual file, 
this section is referred to as the Current Report. The title of the report and the Alternative 
for which results are displayed appear above the Current Report. For example, when you 
open the program, the Summary Report for Alternative 1 appears. 

Below the Current Report: Hint Line 
Below the Current Report is the Hint Line. The Hint Line displays short commands to 
help you with data entry. As you move the pointer across buttons, boxes, and other areas 
of the window, the Hint Line displays different commands. 

Data Entry Sections

 Hint Line 
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Default Values Loaded for the Program 
When you open the Pension & Roth IRA Analyzer or create a new file, the program 
automatically loads a set of default values, creating a simple analysis case. You can 
change these values and save them as your own default file. For example, if you find a set 
of values works well for many of your clients, you can have the program load the values 
whenever you open the program or create a new file. 

Default Assumptions 
The Pension & Roth IRA Analyzer allows you to evaluate various strategies of taking 
distributions from IRAs and qualified pension plans. The program can simultaneously 
calculate up to four scenarios that involve different types of distributions, letting you 
decide which one is best for your clients. 
 
The program assumes that all distributions begin on the required beginning date and that 
distributions are subject to minimum distributions rules under IRC §401(a)(9). The 
program also assumes that no one will be paying the 50% penalty for making 
distributions that are less than the minimum distributions; the program always makes 
minimum distributions. To modify the assumptions, see Input Assumptions. 
Other assumptions include: 

• Spousal rollover 

• AGI method of calculating income taxes  

• Inclusion of estate taxes 

• Adjustment for a Bypass Trust 

Types of Plans & Growth Rates 
You can enter data for a Pension Fund (traditional IRA), a Roth IRA, and an Other Assets 
fund. By default, these funds grow at the same rate, but you can also enter separate 
growth rates for each fund. You can also enter data for multiple gift funds that grow at 
different rates. When entering data for the Pension Fund, the program considers a 
Pension Fund or (traditional IRA) as one of the following types of plans:   

• Corporate and self-employed pension, profit sharing and stock bonus plans 
qualified under IRC §401(a) (includes Keogh or H.R. 10 plans, 401(k) plans and 
employee stock ownership plans (ESOPs). 

• Individual Retirement Accounts (IRAs) under IRC §408(a). 

• Simplified Employee Plans (SEPs) under IRC §408(k). 

• Tax-sheltered annuities (except for account balances existing on 12/31/86 if kept 
separate for accounting purposes) under IRC §403(B). 
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Distributions 
You can enter distributions as living expenses that are “consumed” or taken out of an 
analysis. From both the ordinary and the Roth IRA, you can enter distributions that are 
transferred to the Other Assets fund, including the Lump Sum ten year averaging 
distribution method. The program also contains a Pre-59½ Distributions Calculator that 
will prevent your clients from being subjected to the 10% penalty that results from 
making distributions before age 59½. The program can automatically calculate all 
possible life expectancies of the plan owner, the spouse, and the beneficiary, including 
the hybrid method and term certain method. Also, you can enter insurance premiums and 
proceeds, and you can select the fund from which they are paid. 

Contributions 
You can enter contributions to the Pension Fund (traditional IRA), Roth IRA, and the 
Other Assets fund. Contributing to a pension fund may cause tax savings, and you can 
add this savings to the Other Assets fund. Also, you can add defined benefit annuities to 
an analysis, such as social security benefit. 

Taxes 
You can calculate estate tax using taxable estate values, and the program can calculate 
this taxable estate automatically. You can calculate income tax on a yearly basis using 
separate rates for lifetime distributions, distributions after death, and growth on the Other 
Assets (i.e., after-tax distributions that are invested). Or you can calculate income taxes 
using adjusted gross income values. Other Assets growth may even be modeled as 
realized or unrealized capital gains. 

Roth IRA Conversions 
The program handles 100% conversions and multiple partial conversions for each of the 
four alternatives. For partial conversions, you can use the Roth IRA Conversion 
Optimizer to find the best percentage of an ordinary IRA to convert. To quickly generate 
three conversion scenarios, you can use Quick Roth IRA Conversion. You can select the 
fund from which conversion taxes are paid. 

Reports 
The Pension & Roth IRA Analyzer generates numerous reports and graphs that illustrate 
up to 200 years of results for analysis and comparison. You can use a Report Designer to 
create or modify reports. Also, in the Print Report window, you can group similar reports 
or reports that you will frequently print. You can send all results to a printer, text file, or a 
spreadsheet file. 
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Other Program Tips 

Shortcut Keys 
Use the Function Keys as shortcuts for frequently used program commands. 
F1 Access the Help system. 

F2 Save data to a file. 

F3 Open files. 

F4 Open the Copy Inputs window. 

F5 Copy column values in the Custom Data Entry Window 
and the Living Expenses window. 

F6 Access the Print window. 

F7 Open the Clear Inputs window. 

F8 Switch the results between Actual and Inflation Adjusted 
dollars. 

F9 Recalculate data. 

F10 Access the Reports section. 
F11 Expand the Current Report. 
F12 Expand the most recently viewed report. 
 

Create Desktop Icon 
To create an icon that you can click on to enter the program, choose Create Desktop 
Icon on the file menu. The program will place an icon for you to use from your desktop. 

16 Color Display 
To see the program in 16 colors (rather than 256), go to the Edit menu and choose 16 
Color Display.  
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Chapter 2 
Working with Files 

Frequently Used Procedures 
Refer to this chapter to view instructions for procedures that you’ll frequently use when 
working with files. 

Create a New File 
• On the File menu, click New. The program clears all previous data entry and 

resets the program’s default values. 

Open an Existing File 
On the File menu, click Open. The Open Inputs dialog box appears. 

In the File name box, enter the name of the file to open. Be sure you have selected the 
proper drive and folder of your file. 

Save a File 
On the File menu, click Save. The Save Inputs File dialog box appears. 

In the File name box, type a name for the file. The program automatically adds a .pen 
extension to the file name. 

Select the drive and folder in which to save the file. 

Save an Existing File (Save As) 
Open an existing file or create a new file. 

On the File menu, click Save As. The Save Inputs File dialog box appears. 

In the File name box, enter a name for the new file. The program automatically adds a 
.pen extension to the file name. 

Select the drive and folder in which you want to save the file. 

File Location 
On the File menu, click File Location. The File Location dialog box appears.  

Enter a directory name to which files names should be saved.  
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Save a File as the Default File 
When you open the Pension & Roth IRA Analyzer or create a new file, the program 
automatically loads a set of default values, creating a simple analysis case. From the File 
menu, you can change these values and save them as your own default case. In other 
words, if you find a set of values works well for many of your clients, you can have the 
program load the values whenever you open the program or create a new file. 
 

• Open an existing file or create a new file. 

• On the File menu, click Save Defaults. The Save File of Default Inputs dialog 
box appears. 

• In the File name box, enter a name for the file. The program automatically adds a 
.pen extension to the file name. 

• Select the drive and folder in which to save the file. When you run the program, 
this file will open. 

Load the Default File 
• On the File menu, click Load Defaults. The Default file is loaded. 

Note 
Be sure to save the open file before loading the Default file. Also, first you must save a file as the Default file. 

Delete a File 
On the File menu, click Erase File. The Erase Inputs File dialog box appears. 

In the File name box, enter the name of the file you want to delete (erase). 

Clear Inputs 
Click the Clear Inputs command to delete data from one Alternative or all Alternatives. 
Using the Clear Inputs command is different from excluding an Alternative from an 
analysis. When you exclude an Alternative, the program does not delete the data from the 
file. When you use the Clear Inputs command, the program does delete the data. 

On the Edit menu, click Clear Inputs.  

In the Clear Inputs window, click the Alternatives from which you want to delete data. 
To delete the data from all of the Alternatives, click Clear All Alternatives. 

Click the Clear Inputs button. 

Exit the Program 
• On the File menu, click Exit. The program closes. 

Note 
Be sure to save the open file before clicking the Exit command. 
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Open a Previously Created File 
• On the File menu, click Reopen Files. This allows you to access up to five 

previously created files. 

Converting Older Version Files 
The new file format (using extension “.pen”) uses XML to store information. Version 5 
files are converted automatically. Older files may be converted by using a program called 
PenConv, included with the software. PenConv does not overwrite any data files; it just 
creates new ones. Use short file names with PenConv. It cannot handle long file names 
correctly.  

Set Up a Printer 
• On the File menu, click Printer Setup. 

Display Results in Actual Dollars 
• On the Options menu, click Actual Dollars. The program displays results that 

have not been adjusted for inflation. 

Note 
When you click this Actual Dollars, a check mark appears beside the option. 

Display Results in Inflation Adjusted Dollars 
• On the Options menu, click Inflation-Adjusted Dollars. The program displays 

results that have been adjusted for inflation. 

Note 
When you click this Inflation-Adjusted Dollars, a check mark appears beside the option. 

View the Program in 16 Colors 
• On the Options menu, click 16 Color Display. Your monitor will display the 

program in 16 colors instead of the default 256 colors. 

Note 
When you click this 16 Color Display, a check mark appears beside the option. 

Limit the Number of Years to Display in a Report 
Under the Printing Options heading in the Report Options window, click the Years to 
Include in Report box.  

Enter the number of years you want the printed report to include. 
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Chapter 3 
Overview of Data Entry  

Data Entry Sections & the Reports Section 
The Pension and Roth IRA Analyzer is divided into a number of data entry sections. We 

have developed the data entry sections according to the different areas 
involved in the distribution planning process.  
 
For example, you will enter general information in the Main Inputs 
section, tax information in the Taxes section, contributions to funds in the 
Contributions section, and so on. You don’t need to enter data in every 
section; the amount of your data entry depends on the depth of your 
analysis.  
 
 
When you’re finished entering your data, click the Reports button on the 
left side of the screen. The Reports section appears. The Reports section 
contains a number of Recommended, Analysis, Comparison, and Custom 
reports.  
 
Next, ask yourself what exactly it is that you want to see. For example, 

you may want to see the effects of a distribution from the Pension Fund to the Other 
Assets. With that in mind, click the Analysis tab in the Reports section. Scroll through the 
list until you find a report that you think might answer your question. Possibly, the 
Pension Fund Analysis or the Other Assets Growth Analysis can answer your question.  
 
For more information on the types of reports, see Chapter 16, Viewing Results. 
Use the Edit menu or the buttons pictured above to access the data entry sections. 

Input Assumptions 
It’s a good idea to begin each analysis by entering data in the Input Assumptions window. 
Why? 

• You can select when distributions, conversions, contributions, and adjustments 
occur. 

• You can select the Alternatives that will spend the minimum distributions. By 
default, the program reinvests minimum distributions in the Other Assets.  

• You can select the Alternatives that will reinvest the minimum distributions in the 
Other Assets fund.  
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• You can select the Alternatives that will include the 10% penalty for making Pre-
59½ Distributions. 

Enter Input Assumptions 
On the Edit menu, click Input Assumptions. 

Select Begin or End to determine the time of year that Distributions, Contributions, and 
Adjustments occur. 

If you want to create an Alternative in which the minimum distributions are totally spent, 
click the Alternative under Minimum Distributions Options. If you do not click an 
Alternative, the program reinvests the minimum distributions in the Other Assets fund. 
By reinvesting minimum distributions in Other Assets, you can use the Other Assets fund 
for such things as paying Living Expenses. 

Under Apply Pre-59½ Penalties to Distributions, click the Alternatives that will be 
subject to the 10% Pre-59½ Distributions penalties.  

Client Information 
Click Personal Information on the Edit menu to enter the names of the Planner, Plan 
Owner, Spouse, and Oldest Child into the Client Info section. The Oldest Child can be 
any non-spousal beneficiary. Also, enter a one or two line name for each Alternative you 
create. If a Spouse or Oldest Child is not involved in the case, clear these check boxes. 
The names you enter here appear throughout the program and on the printed reports. 
Also, if you want to print the date on your reports, you must enter the Date Prepared.
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Chapter 4 
Entering General Data for All Alternatives 

Main Inputs Section 
Enter data that applies to all Alternatives in the Main Inputs section. Begin entering data 
in the portion of the window that is pictured below. For help creating Alternatives, see 
Alternative Scenarios. Before entering data in the Main Inputs section, you may want to 
enter the Input Assumptions (Chapter 3) and complete the Client Info section (Chapter 
3). Note: Most discussions of minimum distributions in the help manual refer to the old 
rules (2001 and earlier). See “How do the New Rules Work?” in the Frequently Asked 
Questions, page 69, for a complete discussion.  
 
Main Inputs Section: Table of Inputs 

 
Input  Description 
First Year of Analysis 
 

This year is the starting year for reports. The earliest year that 
you may enter is 1989. However, the program does not include 
the excess distributions or excess accumulation taxes that 
applied to years prior to 1997. 
 

Pension Fund Balance 
 

Enter the value of the Pension Fund as of the beginning of the 
First Year of Analysis. Do not include amounts that have been 
allocated for a former spouse pursuant to a Qualified Domestic 
Relations Order. 
 

Roth IRA Balance Enter the value of all assets that are in the Roth IRA.  
 

Other Assets Balance Enter the total value of the Other Assets fund. You can enter a 
non-liquid balance for the Other Assets fund in the Pension 
Section. 
 

Inflation/Discount Rate By default, the program uses the inflation rate for the after-
death discount rate. The program uses the After-Death 
Discount Rate to adjust after-tax assets for growth after death 
and to calculate the present value of future after tax 

distributions. To enter different rates, click  next to the 
Inflation Rate box. 
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Birth Dates If you have entered names for the Owner, Spouse, and Oldest 
Child in the Client Info section, these names appear in the 
Birth Dates box. Enter birth dates for the Owner, the Spouse, 
and the Oldest Child (spouse’s beneficiary) in month/day/year 
format. The program uses the birth dates to calculate life 
expectancies for the plan owner, the spouse, and the spouse’s 
beneficiary. The Oldest Child can be any non-Spousal 
beneficiary.  
 
If a Spouse or Oldest Child is not part of the analysis, clear 
these check boxes. 
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Alternative Scenarios 
After you’ve entered data in the top portion of the Main Inputs section, begin creating 
your Alternative Scenarios. You will always enter data for Alternative 1. To create other 
Alternatives click the word Here in each column and make the appropriate changes to 
each Alternative. If you want to create identical or nearly identical Alternatives use the 
Copy Alternative command on the Edit menu. An image of Alternative 1 appears below. 
Explanations of each input follow: 
 

 
 
Alternative Scenario: Table of Inputs 

 
Input  Description 
  

Growth Rates Enter the annual percent increase for all of the funds (Pension Fund, 
Roth IRA, and Other Assets). If these funds are growing at different 

rates, click   to enter separate growth rates for each fund. 
Beneficiary 
 

Select Spouse, Child or None. For more information about selecting 
a beneficiary or how the program handles beneficiaries, see Chapter 
21, Reference Material. 

Year Owner Dies You may choose to calculate the analysis assuming that the owner 
survives the calculation, that the owner dies in the year based on   
the plan owner’s life expectancy, or that the owner dies during a 
year you specify.  

Year Benef. Dies You may choose to calculate the analysis assuming that the 
beneficiary survives the calculation, that the beneficiary dies in the 
year based on the beneficiary’s life expectancy, or that the 
beneficiary dies during a year you specify. 
 

Spousal Rollover Click the button next to this heading to specify the conditions of a 
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spousal rollover. Choose from the following options:  

• Spouse rolls over the IRA at the owner’s death. 

• Spouse does not roll over the IRA. 

• Spouse rolls over the IRA in the year you specify. 
 
 
 

Distribution Options In some circumstances, plan owners may begin making minimum 
distributions at times other than the required beginning date. A 
worksheet will pop up when you click on the Required Year button. 
Choose from the following options: 

• Minimum distributions begin when the owner turns 70 ½.  

• Owner defers minimum distributions one year.  

• Owner retires after age 70 ½.  

• Owner makes TEFRA 242 selection. (The TEFRA 242 
designation allows a plan owner to delay commencement of 
benefits until actual retirement, even if it occurs after age 
70½. It assumes a catch-up distribution for the years that 
were deferred after the age 70½ year.) 
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Estate Analysis: 
Max. Deferral 

Whenever the term certain method is applied, the heir has the 
opportunity to defer the withdrawal of the plan balance after 
the plan owner has died or after both parents have died in 
spousal beneficiary cases. 
The Estate Analysis: Max Deferral check box only affects one 
value throughout the program: the Net After-Tax Assets. If this 
check box is selected, the program will include, in the Net After-
Tax Assets, the Present Value of Future After-Tax Distributions 
that the heir can make over his or her term certain life expectancy. 
If you clear this check box, the program will not include the Present 
Value of Future After-Tax Distributions in the Net After-Tax 
Assets, and it will assume that the heir takes a lump sum 
distribution from the Pension Fund upon the death of the second-to-
die. By default, the program taxes the distribution and reinvests it in 
the Other Assets. You can adjust the after-tax assets for growth 
after death using the After-Death Discount Rate.  

Tip 
A good way to visualize the effects of Estate Analysis: Max Deferral is 
to view the Estate Analysis Report. Create one Alternative in which you 
select Estate Analysis: Max Deferral and one in which you don’t. Then 
compare the Estate Analysis Reports for both Alternatives. 

 

Multiple Alternatives 
Click Copy Alternative to copy data from one Alternative to other Alternatives. This is a 
good way to create Alternatives with nearly the same data. For instance, after you copy 
an Alternative you can then change only the specific items that make the Alternatives 
different, such as Year Owner Dies or Growth Rates. 

On the Edit menu, click Copy Alternative. The Copy Inputs window appears. 

In Copy From box, click the Alternative from which you want to copy data. 

In the Copy To box, click the Alternative(s) that will receive the copied data. 

Click the Copy Inputs button. 

Note 
You do not have to be working in the Main Inputs section to perform this procedure. However, to avoid 
confusion, you may want to use Copy Alternative to set up the basis for your Alternatives before you enter 
data in the rest of the program. 
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Chapter 5 
Entering Tax Information 

Taxes Section 
Use the Taxes section to enter income taxes and estate tax information to an analysis. The 
program calculates income taxes using one of the following methods: 

• Income Tax Rates method. If you use entered rates, the program provides a 
calculator to help you pick the proper rates. 

• AGI method. By default, the program uses the AGI method.  

Income Tax Rates Method 
When calculating income tax using entered rates, the income tax rate should include state 
and federal tax rates. It should include (a) possible state income tax deductions, (b) the 
possible loss of a full deduction because of the rule reducing itemized deductions by 3% 
of the AGI for certain high income taxpayers, and (c) the impact of the alternative 
minimum tax. 
 

Tax Rates Tab: Table of Inputs 
 

Input  Description 
Tax on Pension Fund 
Distributions 
 

Distributions from retirement plans are generally subject to 
federal income taxes, and in most cases, state and local income 
taxes. The program can calculate income tax on lump sum 
distributions with ten year averaging. 

Tax Rate During 
Conversion 
 

A qualified conversion from one Roth IRA to another Roth 
IRA is tax-free regardless of the taxpayer’s AGI. However, 
qualified conversions from Ordinary IRAs to Roth IRAs are 
considered taxable distributions, and they are taxed 
accordingly. However, if conversions occur before age 59½, 
the conversion amounts are not subject to the 10% penalty tax 
on Pre-59½ distributions. 

Tax on Growth of Other 
Assets 

The program calculates income tax on the liquid portion of the 
Other Assets fund each year. You can enter a non-liquid 
balance to reduce taxes. Also, the program allows you to use a 
capital gains tax rate for growth of Other Assets. 

Tax on Pension Fund at 
Death 

Even after a plan owner’s death, beneficiaries receiving 
distribution benefits must pay income tax as “income in respect 
of a decedent.” Funds left to charity, however, may be free of 
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income tax. Also, funds left to a spouse may be “rolled-over” 
on a tax-deferred basis to an IRA. 
 

Custom button To enter different tax rates for each year, click the Custom 
button. For more information on Custom Data Entry, see 
Chapter 15, Custom Data Entry. 

Income Tax Rate Calculator 
If you’re calculating income tax using entered rates, the Income Tax Rate Calculator can 
calculate the rates for you. If you need help figuring tax rates, click the computer graphic 
that’s next to each field. The Income Tax Rate Calculator will help you find the 
appropriate rate.  

Using the Income Tax Rate Calculator 

Click   next to the tax rate you want to calculate. The Income Tax Rate Calculator 
appears. 

In the Filing Status group box, click Single, Married, Filing Jointly, or Head of 
Household. 

Enter the plan owner’s Adjusted Gross Income. 

Enter the Number of Exemptions that the plan owner claims. 

Take note of the Income Tax. 

Click Average Tax Rate or Marginal Tax Rate for calculating income tax. 

AGI Method 
By default, the program uses the AGI method. The program only uses the income that 
you enter in the AGI section to calculate income taxes. Other parts of the program cannot 
“see” or use the income that you enter here. For example, let’s say you enter an AGI of 
$60,000, and you also enter a $20,000 living expense paid from Other Assets. The 
program cannot pay the living expense using the $60,000 unless you’ve included the 
$60,000 in the Other Assets. To pay the living expense, you could enter $40,000 in the 
AGI section. Then you could enter a $20,000 Taxable Annuity (using the Pension 
section). The program adds Taxable Annuities to the Other Assets.  
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AGI Tab: Table of Inputs 

 
Input  Description 
Owner’s AGI 

 
Enter the Owner’s AGI. This is the total amount of taxable 
income that you haven’t already entered into the program. For 
example, if you entered any Taxable Annuities, do not include 
them in the Owner’s AGI box. Taxable Annuities are 
considered income, so you don’t want to enter the same 
income in different portions of the program, or the program 
taxes the income multiple times. 

Growth Enter the annual percent increase of the Owner’s AGI. 
From/To Boxes Use these boxes to enter the span of years for which the AGI 

applies. To enter AGIs for specific years, click Override with 
Custom AGI Values. For override procedures, see Chapter 15, 
Custom Data Entry. 

1, 2, 3, 4 The numbers in the Adjusted Goss Income section represent 
the Alternatives. Select the Alternatives for which the AGI 
applies. 

Estate Analysis AGI This is the Heir’s AGI. By default, the program includes the 
Heir’s AGI in all Alternatives. To exclude the Heir’s AGI from 
an Alternative, enter a zero value. Enter a growth rate. 

Tax on Growth of Other 
Assets 

Growth of Other Assets is taxable. Enter the tax rate for the 
growth of the Other Assets fund. This does not represent the 
tax rate on the growth of the Heir’s Other Assets. 

Override/Custom Buttons For more information on Custom Data Entry, see Chapter 15, 
Custom Data Entry. 

Estate Taxes 
Recent changes in estate tax law have resulted in higher exemption amounts and other 
changes affecting estate tax calculations. 

Pension and Roth IRA Analyzer allows you to select between three potential scenarios. 

• 2011 Sunset 

• 2010 Repeal in 2010+  

• 2009 Rates in 2009+  (program default) 
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These choices will affect program computations for 2010 and later years only.   
 
Explanation: 
2011 Sunset (current law with sunset):  Assumes repeal occurs in 2010 and prior law 
returns in 2011 with a 55% top rate and $1 million exemption. This is way the tax law is 
currently written. This may be a reasonable assumption if one believes that no changes to 
the current law are likely and that the sunset provisions will prevail. One of the other two 
choices may be a better assumption if one believes that the sunset provisions will not be 
implemented due to future law changes. 
    
2010 Repeal in 2010+ (current law modified to remove sunset and make repeal 
permanent):  Assumes repeal becomes effective in 2010 and stays effective thereafter. 
This is what was originally intended by the tax writers, but ultimate repeal remains 
uncertain due to the inclusion of sunset provisions. This may be a reasonable assumption 
if one believes that the sunset provisions will not be implemented and repeal will 
ultimately prevail.   

2009 Rates in 2009+ (current law modified to continue estate tax with no repeal):  
Assumes repeal never occurs and last scheduled rates are used in future years. This may 
be a reasonable assumption if one believes that repeal is unlikely to occur.   

By default, the program includes estate taxes in each analysis. The taxable estate is the 
total gross estate of a plan owner after deducting debts, applicable taxes, charitable or 
religious deductions, benefits to a surviving spouse, losses, and any specific exemptions. 
This includes the balances of the Pension Fund, Roth IRA, and Other Assets. You can, 
however, calculate the taxable estate by entering its total value based on after-tax assets.  
The program applies the federal estate death tax credit to the combined balance of the 
Pension, Roth IRA, and Other Assets. This tax rate ranges from 37% to 55%, depending 
on the size of the estate. If a particular state has a higher tax than the credit, the program 
still uses the amount of the credit. 

 

Note 
By default, the middle check box above is checked. To calculate the Taxable Estate based on after-tax 
assets, clear the middle check box. Then the Taxable Estate Amount section appears. 
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Estate Tax Tab: Table of Inputs 

 
Input  Description 
Include Estate Tax 
Calculations 

By default, the program includes estate tax calculations. Clear 
this check box to exclude estate tax calculations. 

Taxable Estate= Other 
Assets + Pension Fund + 
Roth IRA 

Normally the program calculates estate taxes based upon the 
Pension Fund, Other Assets, and Roth IRA. However, you can 
enter your own taxable estate values if you prefer. For 
example, you can enter different amounts for different years 
with each amount growing at its own rate (see Taxable Estate 
below). 

  
Taxable Estate If you have cleared the check box labeled Taxable Estate = 

Other Assets + Pension Fund + Roth IRA, the Taxable Estate 
Amount area appears. This allows you to enter your own 
values for the taxable estate. 

Growth Enter the annual percent increase of the Taxable Estate 
Amount. 

From/To Boxes Use these boxes to enter the span of years for which the 
Taxable Estate Amount applies. To enter Taxable Estate 
Amounts for specific years, click Override with Custom 
Taxable Estate Values. For override procedures, see Chapter 
15, Custom Data Entry. 

1, 2, 3, 4 These numbers represent the Alternatives. Select the 
Alternatives for which the Taxable Estate Amount applies. 

Grow Estate From (year) 
instead of entered “From” 
Year 

In general, you’ll be planning for the future, so you’ll probably 
want to adjust for inflation. By default the program applies the 
growth rate on the Taxable Estate amounts from the first year 
of analysis instead of from the “From” year. This ensures that 
the program has adjusted the Taxable Estate Amount for 
inflation. 

Override with Custom 
Taxable Estate Values 

Click this button to enter Taxable Estate Amounts on a year-
by-year basis instead of over a span of years. When you enter 
Custom Taxable Estate Amounts, the program replaces the 
initial amounts with the custom amounts. For more information 
on Custom Data Entry, see Chapter 16, Custom Data Entry. 
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Bypass Trust Tab 
Adjust Taxable Estate for 
Bypass Trust / Bypass 
Trust Growth Rate 

By default, if the plan owner has a spousal beneficiary, the 
program automatically adjusts the taxable estate for a bypass 
trust. This means that the plan owner will combine a bypass 
trust with a marital deduction trust. Such a combination is 
sometimes referred to as an A-B Trust. In an A-B Trust, the 
estate owner places an amount of money equal to the 
equivalent exemption (based on the unified credit) in a bypass 
trust therefore excluding it from the estate of the second-to-
die. Of course, this results in a lower federal estate tax. The 
equivalent exemptions based on the unified credits are scaled 
according to the Taxpayer Relief Act of 1997. Although the 
program automatically adjusts the estate in this manner, you 
must enter the growth rate of the trust. 
If you don’t want to adjust the taxable estate for a bypass 
trust, for each alternative, click No. 

 

Section 691(c) Deduction 
Upon the death of a plan owner, the balance remaining in retirement plans may be subject 
to federal estate tax and it may also be subject to state inheritance or estate taxes. 
However, the Section 691(c) Deduction allows heirs to limit the amount of tax on 
distributions from inherited plans. If you include estate tax calculations in an analysis or 
if there is deferred income tax, you need to apply the Section 691(c) Deduction. Benefits 
left to charity may be exempt from estate taxes. You can apply the Section 691(c) 
Deduction using the Annuity method or the Front Loaded method. 
To see how the program applies the Section 691(c) Deduction, go to the Reports section, 
click the Analysis tab, and view the Taxable Amount of Pension Fund report. 

Using the Annuity Method 
The Annuity method is the program’s default method of applying the Section 691(c) 
Deduction. Using the estate tax that is attributable to the Pension Fund, the program 
calculates the value of the Section 691(c) Deduction. Next, it divides the Section 691(c) 
Deduction by the Pension Fund Ending Value to arrive at a deduction ratio. By 
multiplying the annual distribution by the deduction ratio, the program calculates an 
annual deduction. Each year, the program subtracts the annual deduction from the heir’s 
distribution, and the heir pays tax on the remaining amount of his or her distribution. The 
annual deduction reduces the remainder of the Section 691(c) Deduction each year until it 
is totally consumed.  
 

Here’s another way to look at the Annuity Method 
Section 691(c) Deduction = Estate Tax on Pension Fund 
Deduction Ratio = Section 691(c) Deduction / Pension Fund Ending Value 
Annual Deduction = Annual Distribution * Deduction Ratio 



Chapter 5:  Entering Tax Information 

 27

Taxable Amount of Annual Distribution = Annual Distribution – Annual Deduction 
Remainder of Section 691(c) Deduction = Section 691(c) Deduction – Annual Deduction 

Using the Front Loaded Method 
Using the estate tax that is attributable to the Pension Fund, the program first calculates 
the value of the Section 691(c) Deduction. By applying the Front Loaded method, the 
program subtracts each distribution that the heir makes from the calculated Section 
691(c) Deduction until the deduction is entirely consumed. These distributions are 
essentially tax-free. Once the Section 691(c) Deduction is used, the distributions start 
generating income tax. 

Filing Status      
When calculating income tax from adjusted gross incomes, you need to enter the Filing 
Status of the Owner, Spouse, and Oldest Child (spouse’s beneficiary). If you’ve entered 
names for the Owner, Spouse, and Oldest Child in the Client Info section, the names 
appear in the Filing Status section. 

Enter Filing Status 
Click the Filing Status tab. When clicked, the tab is highlighted in yellow. 

In the Number of Exemptions column, enter the number of exemptions for each 
Taxpayer. 

In the Itemized Deductions column, enter the dollar amount of itemized deductions for 
each Taxpayer. 

In the Filing Status column, click each box. 

In the list that appears, click the filing status for each Taxpayer. 

Conversion Taxes 
Conversions to a Roth IRA from either an Ordinary IRA or another Roth IRA are 
allowed only if they are qualified according to Code Sec. 408(d)(3) requirements (60-day 
rollover rules). A qualified conversion from one Roth IRA to another Roth IRA is tax-
free regardless of the taxpayer’s AGI. However, qualified conversions from Ordinary 
IRAs to Roth IRAs are considered taxable distributions, and they are taxed accordingly. 
However, they are not subject to the 10% penalty tax on Pre-59½ Distributions. 

Note 
Plan owners cannot convert an ordinary IRA to a Roth IRA if their AGIs for the year exceed $100,000, or they 
are married filing a separate return for the year. Taxpayers who made qualified conversions before Jan. 1, 
1999 had the ability to spread-out conversion tax over 4 years, beginning with the year that the distribution 
took place. (§302)  
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Select the Fund from which to Pay Conversion Taxes 
In the Taxes section, click the Conversion Tax tab. When clicked, the tab is highlighted 
in yellow. 

Click or clear Spread Out Payment of 1998 Conversion Tax. 

Click the Alternative 1 box. 

In the list that appears, click the fund from which conversion taxes will be paid. 

Repeat Steps 3-4 for the other Alternatives. 

Note 
If you’re using Quick Conversion, you do not need to enter conversion taxes in the Taxes section. Quick 
Conversion automatically enters conversion taxes. 

Spread Out Payment of 1998 Conversion Tax 

• If a Conversion was made in 1998, the plan owner had the option of paying 
conversion taxes over a four-year period. This option is not available to 
conversions made after 1998. 
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Chapter 6 
Modeling Income and Expenses 

Income and Expenses Section 
Use the Income and Expenses section to enter distributions that are “consumed” and 
those that are received as income. Expenses are not transferred to the Other Assets fund.  

Income 
Income—money coming in to the client—is used to pay expenses and is then reinvested 
in the Other Assets category Income shows up on the Distributions report as “Net 
Amount from Income.”  
 
Input  Description 
Add Expense button 

Remove button 
Click the Add Expense button to enter a new expense.  

Click the Remove button to delete the highlighted expense.  
Description Enter a short description for each income or expense. The 

description is optional. 
Annual Income Enter the net amount of money that your client has as income 

annually. 
Invest Income In Select the fund in which the income will be invested. 
Annual Increase Enter the amount the income will increase annually. 
Receive Income From Use these boxes to enter the span of years that the income will 

be received. To enter income on a year-by-year basis, click the 
Year-by-Year Income button.  

Year-by Year Income Click this button to enter income for specific years instead of 
entering income that covers a span of years.  

Apply Growth Rate from 
(first year of 
analysis)(instead of first 
year expense applies) 

In general, you’ll be planning future income, so you’ll 
probably want to adjust income for inflation. By default the 
program applies the growth rate on the income from the first 
year of analysis instead of from the first year that the plan 
owner needs the income. This ensures that when the income is 
distributed, it has been adjusted for inflation.  
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Expenses 
Descriptions of living expenses appear in top portion of this section. A description of a 
living expense appears by default. For example, the entry may read “$0 from 1999 to 
2057.” This description changes as you enter data in the boxes below the description box. 
The numbers on the right side of the box (1, 2, 3, 4) represent the Alternatives that 
include the expense. Expenses can now be specified to be not grossed up for income 
taxes. Uncheck the box labeled “Amount Needed After Taxes” to indicate that the 
amount needed for a given living expense should be decreased by the taxed paid on that 
living expense. Living expenses are now paid first out of income.  
 
Input  Description 
Add Income button 

Remove button 
Click the Add Income button to add to enter a new income.  

Click the Remove button to delete the highlighted income.  
Description Enter a short description for each income. The description is 

optional. 
Amount Needed Enter the net amount of money that your client needs for living 

expenses annually. The program distributes the gross amount 
and applies the appropriate taxes to each expense. Do not add 
the minimum distribution to the Amount Needed. If the 
Amount Needed is less than the minimum distribution, the 
program adds the remainder of the minimum distribution to 
Other Assets (unless you specify otherwise in the Input 
Assumptions). 

 
 

Pay Expenses From Select the fund from which living expenses will be paid. Be 
sure that the fund has enough money to pay the expense(s). If 
the expense uses the entire fund, and you’ve specified that the 
expense is needed for a longer time period than the fund will 
last, the program begins paying the expense from the other 
funds. 

Since you indicate the fund from which expenses are paid, 
some good reports that reflect living expenses are the 
Distributions Breakdown, the Pension Fund Analysis, the Roth 
IRA Analysis, the Other Assets Analysis, the Roth IRA 
Distributions report, or the Total Pension and IRA 
Distributions report. 

 
Growth Rate Enter the annual percent increase of the living expense. 
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Make Payments From Use these boxes to enter the span of years that the living 
expense is needed. To enter living expenses on a year-by-year 
basis, click the Year-by-Year Expenses button. Be sure that the 
fund from which the expense(s) will be paid has enough 
money to cover the time span that you indicate in the From/To 
boxes. If the expense uses the entire fund, and you’ve specified 
that the expense is needed for a longer time period than the 
fund will last, the program begins paying the expense from the 
other funds. 

Year-by Year Expenses Click this button to enter living expenses for specific years 
instead of entering living expenses that cover a span of years.  

Apply Growth Rate from 
(first year of 
analysis)(instead of first 
year expense applies) 

In general, you’ll be planning future living expenses, so you’ll 
probably want to adjust living expenses for inflation. By 
default the program applies the growth rate on the expense 
from the first year of analysis instead of from the first year that 
the plan owner needs the expense. This ensures that when the 
living expense is distributed, it has been adjusted for inflation.  
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Chapter 7 
 Modeling Pension Fund Activity 

Pension Section 
Use the Pension section to transfer distributions from the plan owner’s Pension Fund to 
the Other Assets. The distributions that you enter here are not consumed, only 
transferred. The program applies taxes to Pension Fund distributions. 
You can also use the Pension section to access the Pre-59½ Distributions Calculator or 
the Lump Sum Distribution window. Also the Pension section enables you to add 
Taxable Annuities via the Custom Data Entry window.  
 
Input  Description 
Description (top) 

 
In this box, enter a short description of the Pension Fund. The 
description is optional. 

12/31/(year) Pension 
Fund Balance 

Enter the 12/31 balance of the Pension Fund for the preceding 
year. The program requires a 12/31 balance for required 
minimum distribution calculations. If you entered a Pension 
Fund balance in the Main Inputs section, the balance should 
appear in this box. 

12/31/(year) Non-
Deductible Balance 

Enter the Non-Deductible portion of the Pension Fund balance. 
The program will not tax the Non-Deductible Balance. Non-
Deductible Balances occur when plan owners do not qualify 
for deductions on Pension Fund contributions. 

Description (bottom) Enter a short description for each distribution. The description 
is optional. 

Distribution Enter the annual amount of each Pension Fund distribution. 
Note 
The program always distributes at least the required minimum distribution 
from the Pension Fund, so don’t worry if a distribution is too small. If you 
enter a distribution that is larger than the Pension Fund balance, the 
program distributes the balance. Also, if you enter a distribution in dollars 
and a distribution in percent (Custom Data Entry window) for the same 
year, the program calculates and applies the dollar amount first. 

 

Growth Rate Enter the annual percent increase of the distribution. 

From/To Boxes Use these boxes to enter the span of years for which the 
distribution is needed. 



Chapter 8:  Modeling Pre-591/2 Distributions 

 36 

Apply to Alternative These numbers represent the Alternatives. Selected check 
boxes indicate which Alternatives will include the distribution. 

Apply Growth Rate from 
(current year)(instead of 
entered “From” year) 

In general, you’ll be planning future distributions, so you’ll 
probably want to adjust distributions for inflation. By default 
the program applies the growth rate on the distribution from 
the first year of analysis instead of from the first year that the 
plan owner needs the distribution. This ensures that when the 
distribution occurs, the program has adjusted it for inflation.  

Custom Pension Fund 
Distributions 

Click this button to enter distributions on a year-by-year basis 
instead of over a span of years. The program adds these 
distributions to any distributions you add in the Pension 
section. 

 

Pre-59½ Distributions Button 
Click this button to enter Pre-59½ Distributions to an analysis. 

Lump Sum Distributions Button 
Click this button to enter Lump Sum Distributions to an analysis. Use the Lump Sum 
Distribution Window to distribute the total Pension Fund balance to the Other Assets 
fund. The 10-Year Averaging option is available for plan owners who were at least age 
50 on January 1, 1986. The program calculates income tax using 1986 tax rates (see IRS 
Announcement 87-105, 1987-48 I.R.B. 32). 
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Chapter 8 
Modeling Pre-59½ Distributions 

The Pre-59½ Distributions Calculator 
 
Use the Pre-59½ Distributions Calculator to calculate the “substantially equal periodic 
payments” that plan owners need to make in order to avoid the 10% penalty for early 
distributions. We’ve divided this process into three steps. To access the Pre-59 ½ 
Distributions Calculator, click Pre-59½ on the toolbar. The Pre-59½ distributions screen 
shows only those inputs that are relevant to the current case. If the input is irrelevant to 
the case, the input field will disappear. Enter information in order (from top to bottom). 

 

Input    Description 
Starting Date: Enter the first year that the plan owner needs the Pre-591/2 

Distribution. When the Distribution Frequency is 
Semiannual, Quarterly, or Monthly, the Starting Date 
determines the date of the pre-50 ½ distribution. 

 
Distribution Year: For most cases, this input should be the same as the year of 

the Starting Date.  However, if your client started taking 
Pre-59½ Distributions in a previous year, you can use this 
input to calculate the distributions for the current year.  Set 
the Starting Date to be when Distributions started, and enter 
the current year as the Distribution Year. 

 
Distribution Method: There are three methods for calculating early distributions: 

Minimum Distributions, Amortization, and Annuitization 
Method (see the IRS Notice 89-25 in Chapter 21, Reference 
Materials.)  
 
“Switch: Min. Distrib” should be used for clients who are 
already taking distributions and want to switch to the new 
minimum distribution method. It causes the distribution 
calculation to be based on the balance in the plan as of the 
point that the distributions begin (rather than the balance at 
the end of the previous year).  

 
Calculation Method: See “Revenue Rule 2002-62” in Chapter 21, Reference 

Materials, for more information about this ruling. Pre-2002, 
for most cases, select IRS Notice 89-25. Private Letter 
Rulings (among them 9531039, 9010075, and 9241063) 
illustrate an annual recalculation of distributions for the 
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Annuitization Method and amortization methods. More 
specifically, in years after the first year, the distributions 
are recalculated using the balance as of the beginning of 
each year. If you wish to see the distributions calculated 
using the methodology of the Letter Rulings, select 
“Private Letter Rulings” for the choice. The program 
includes disclaimer language on all reports that use the 
method of the Private Letter Rulings. These Letter Rulings 
deal with cases involving the start of new qualifying 
distributions. They do not deal with cases involving 
distributions that have already commenced.   

 
Plan Balance: Enter the value of all assets in the plan. The Minimum 

Distributions rules require that you enter the balance of the 
plan as of December 31 of the year preceding the first year 
of analysis. After the first year, the Private Letter Rulings 
also use the 12/31 plan balance to calculate distributions. 
This input is enabled only when it is relevant to the 
calculations. When Rev. Rule 2002-62 applies, the 
minimum distributions method is calculated using the 
balance as of the first distribution in each year.  

 
Expected Plan Growth: Enter the expected annual growth of the plan. This rate is 

not used to calculate the distributions but is just used for 
projections.  

 
Distribution Frequency: Select a Distribution Frequency. Plan owners can make 

pre-59½ distributions Annually, Semiannual, Quarterly, or 
Monthly. Depending on the Distribution Frequency, the 
Plan Balance is calculated differently. For example, if the 
Distribution Frequency is Annual, the growth is 
compounded only once each year. If it is Semiannual, 
compounding occurs twice. If it is Quarterly, compounding 
occurs four times each year. If it is Monthly, then 
compounding occurs every month. 

 
Joint/Single Life Exp.: Select whether to base the calculation of distributions on a 

single or a joint life expectancy. 
 
Birth Dates: Enter the owner’s birth date and the beneficiary’s birth date 

in month/day/year format. The beneficiary’s birth date is 
used to determine joint life expectancy factors. 

 
Use Maximum Interest Rate: Rev. Rul. 2002-62 defines the maximum “reasonable 

interest rate” to be the highest applicable federal midterm 
rate of the two months prior to the first distribution.  
Answering yes to this question causes the program to fill in 
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the “reasonable interest rate” automatically, disabling that 
input field. If no federal midterm rate has been entered, the 
program displays a message and the "Use Maximum 
Interest Rate" input is set to “No.” 

 
 “Reasonable” Interest Rate: If the Distribution Method is Annuitization or 

Amortization, enter a “Reasonable” Interest Rate (see 
Chapter 21, Reference Material). To create a Comparison 
Report, you need to enter a Reasonable Interest Rate. 

 
Use Uniform Life Table: If the owner is still alive, the life expectancy is taken 

straight from the Uniform Lifetime Table. Simply find the 
owner’s age on the table (it covers ages 70 through 115), 
and use the life expectancy listed. For this situation, the 
only change caused by the 2002 final regulations was to 
update the numbers in the Uniform Lifetime Table. 

 
Annuity Factor Table: If the Distribution Method is Annuitization, select the 

Mortality Table (or details, see Chapter 21, Reference 
Material) that the program will use to calculate annuity 
factor. To create a Comparison Report, you need to choose 
an Annuity Factor Table. 
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Step 2: Choose a Distribution Method 

 

Input Description 

 

Distribution Method 
 

There are three methods for calculating early distributions: 
Minimum Distributions, Amortization, and Annuitization 
Method (see the IRS Notice 89-25 in Chapter 11, Reference 
Material).  

 
 

“Reasonable” Interest Rate 
If the Distribution Method is Annuitization Method or 
Amortization, enter a “Reasonable” Interest Rate (see Chapter 
11, Reference Material). To create a Comparison Report, you 
need to enter a Reasonable Interest Rate.  

Calculation Method 

 

 

 

 

 

 

 

 

 

 

 

12/31/(year) Plan Balance 

For most cases, select IRS Notice 89-25.  Private Letter Rulings 
(among them 9531039, 9010075, and 9241063) illustrate an 
annual recalculation of distributions for the Annuitization 
Method and amortization methods. More specifically, in years 
after the first year, the distributions are recalculated using the 
balance as of the beginning of each year.  If you wish to see the 
distributions calculated using the methodology of the Letter 
Rulings, select "Private Letter Rulings" for the choice.  The 
program includes disclaimer language on all reports that use the 
method of the Private Letter Rulings. These Letter Rulings deal 
with cases involving the start of new qualifying distributions.  
They do not deal with cases involving distributions that have 
already commenced.   

 

Enter the value of all assets in the plan. The Minimum 
Distributions rules require that you enter the balance of the plan 
as of December 31 of the year preceding the first year of 
analysis. After the first year, the Private Letter Rulings also use 
the 12/31 plan balance to calculate distributions. This input is 
enabled only when it is relevant to the calculations. 
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Chapter 9 
Modeling Roth IRAs 

Roth IRA Section 
Use the Roth IRA section to enter Roth IRA Conversions and Roth IRA Distributions to 
an analysis. Roth IRA Conversions take place at the same time as Pension Fund 
Distributions. However, when contributions, pension fund distributions, and conversions 
all occur in the same year, the program makes them in the following order: 

• Contributions 

• Distributions 

• Conversions 
 
The program uses this method because minimum distributions are subject to different tax 
rules than conversions. The program calculates minimum distributions regardless of the 
conversion amount. Also, plan owner’s can make contributions and convert them without 
any problem. Furthermore, distributions can reduce conversions. For example, if a 
$100,000 fund has a minimum distribution of $50,000 and a conversion amount of 
$70,000, the conversion amount will be reduced to $50,000. 

Note 
If you’re using Quick Conversion, you do not use the Roth IRA section to enter conversions. 

Roth IRA Conversions 
Conversions to a Roth IRA from either an Ordinary IRA or another Roth IRA are 
allowed only if they are qualified according to Code Sec. 408(d)(3) requirements (60-day 
rollover rules).  
 
There is an income test that determines whether or not a plan owner is eligible to convert. 
Plan owners cannot convert an IRA to a Roth IRA during any year in which their AGIs 
exceed $100,000 or during any year in which they are married and filing separate tax 
returns. If plan owners pass the income test, they can convert an unlimited amount of 
money from the ordinary IRA to the Roth IRA. If plan owners made conversions in 1998, 
they had the opportunity to pay the conversion taxes over a four-year period by adding 
25% of the conversion amount to their gross incomes for each of the four years.    

Note 
If you’re using Quick Conversion, you do not use the Roth IRA section to enter conversions. 

Enter a 100% Conversion 
Click the Conversions tab. When active, the tab is highlighted yellow. 
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Enter 100% in the Alternative column. Enter the year of the conversion in the Year 
column. 

In the Taxes section, click the Conversion Tax tab and select the fund from which 
conversion taxes will be paid. 

Enter Partial Conversions 
When entering conversion amounts, you can enter dollar amounts or percentages to 
convert. The program treats values less than 100 as percentages. Due to growth rates, 
contributions, living expenses, and the source of conversion tax payments, it is difficult to 
model a year-by-year conversion scenario with equal conversion amounts. However, 
we’ve provided the following example to demonstrate a simple conversion over four 
years. Let’s assume the Pension Fund balance is $100,000. 

 

Click the Conversions tab. When active, the tab is highlighted yellow. 

In the Year column, enter the years in which the conversions occur. 

Enter one quarter of the Pension Fund balance ($25,000) for years one, two, and three. 

Enter 100% for the fourth year.  

In the Taxes section, click the Conversion Tax tab and select the fund from which 
conversion taxes will be paid. 
Depending on growth rates, living expenses, contributions, and the source of conversion 
tax payments, the fourth year conversion amount may be higher or lower than years one, 
two, and three.  

Note 
If you want to convert the plan over a four-period, do not enter 25% for four years. This would only convert 
25% of the total fund each year. 

Custom Roth IRA Conversions 
Click this button to enter conversions over a greater number of years than is possible 
from the Conversions tab. The program adds these conversions to any conversions that 
you enter on the Conversions tab. 

Roth IRA Distributions 
Qualified distributions from a Roth IRA are not included as income and are tax-free. 
Non-qualified Roth-IRA distributions are taxable, including distributions within five-
years of the first Roth IRA contribution. For distributions caused by rollovers from a non-
Roth IRA, the five-year period begins with the tax year in which the rollover occurred. In 
the case of Pre-59½ distributions, the taxable portion of Pre-59½ distributions will be 
penalized subject to the 10% penalty (exceptions applicable to premature distributions 
from non-Roth IRAs). If plan owners make nonqualified distributions, contributions to 
the Roth IRA will be recovered tax-free before earnings are taxed. 
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However, if plan owners make distributions within the five-year period, the distributions 
could still be tax-free. This is because Roth IRA distributions are paid from any 
contributions that plan owners may have made that year. Since plan owners pay taxes 
when they contribute money to a Roth IRA, they do not have to pay taxes on this same 
money when they withdraw it from the Roth. But if plan owners make distributions 
(within the five-year period) that exceed the amount of the contributions, then the plan 
owners must pay taxes on the excessive distributions.  
After the five-year period, a Roth IRA distribution is tax-free if it meets the following 
criteria: 

• The distribution occurs on or after age 59½ or death. 

• The distribution occurs on account of disability. 

• The distribution pays expenses for qualifying first time homebuyers. 
 
Distributions from a Roth IRA will not be subject to the required distribution rules of 
Code Sec. 401(a)(9)(A) or the incidental death benefit rules of Code Sec. 401(a). 
 
Roth IRA Distributions Tab: Table of Inputs 

 
Input  Description 
Description (top) Enter a short description for each distribution. The description 

is optional. 
Starting Balance Enter the balance of the Roth IRA. If you’ve entered a balance 

in the Main Inputs section, it should appear in this box. 
Description Enter a description for the Roth IRA. This is optional. 
Distribution Enter the annual amount of each Roth IRA distribution. 
Growth Rates Enter the annual percent increase of the distribution. 
From/To Boxes Use these boxes to enter the span of years for which the 

distribution is needed. 
Apply to Alternative These numbers represent the Alternatives. Selected check 

boxes indicate which Alternatives will include the distribution. 
Apply Growth from (first 
year of analysis)(instead 
of “From” Year) 

In general, you’ll be planning future distributions, so you’ll 
probably want to adjust distributions for inflation. By default 
the program applies the growth rate on the distribution from 
the first year of analysis instead of from the first year that the 
plan owner needs the distribution. This ensures that when the 
distribution occurs, the program has adjusted it for inflation. 

Custom Roth IRA 
Distributions 

Click this button to enter distributions on a year-by-year basis 
instead of over a span of years. The program adds these 
distributions to any distributions that you enter on the 
Distributions tab. 
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Chapter 10 
Quick Conversion & the Roth IRA Conversion Optimizer 

Quick Roth IRA Conversion 
Use Quick Conversion to determine if the plan owner should make a 100% conversion to 
a Roth IRA in the current year. The program creates three conversion scenarios allowing 
you to analyze and compare the effect of each scenario on the Net After-Tax Assets. To 
access Quick Conversion click Quick Conversion on the toolbar. 

 

Note 
One of the scenarios that Quick Conversion creates pays conversion taxes from the Other Assets. To create 
an accurate analysis, your client should have enough money in the Other Assets to pay the conversion 
taxes. If not, the program will create an Other Assets balance large enough to pay the taxes. Also, you do not 
need to use Quick Conversion for Roth IRA scenarios. You can use the Roth IRA section if you’d like. See 
Chapter 9, Modeling Roth IRAs. 

Step 1: Get Ready 
Quick Conversion creates three conversion scenarios allowing you to analyze and 
compare the effect of each scenario on the Net After-Tax Assets. If you want the program 
to create these scenarios, before you begin using Quick Conversion, enter all Main Inputs 
section data, including data for Alternative 1. Any data in Alternatives 2 and 3 will be 
replaced with new data.  

Step 2: Entering Tax Information 
You can calculate income taxes using the plan owner’s adjusted gross income or by 
entering tax rates. 

• If you click Calculate taxes from an AGI, enter the plan owner’s adjusted gross 
income. If the plan owner is already making required minimum distributions, do 
not include the minimum distributions in the AGI. The program will do this 
automatically. 

• If you click Use Rates to calculate taxes, enter the tax rate that the owner 
normally uses in the Normal Tax Rate box. Then enter a tax rate for the 
conversion period in the During Conversion box. If you want the program to 
calculate these rates for you, click the Calculate button next to each of the boxes 
to open the Income Tax Rate Calculator. 

Step 3: Select How Much to Convert 
Quick Conversion will convert 100% of the ordinary IRA, or you can use the Roth IRA 
Optimizer to find the best percentage of the IRA to convert. 
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• If you want the program to convert 100% of the IRA, click Convert 100% of the 
Ordinary IRA. 

• If you want to use the Roth IRA Optimizer, click Calculate the optimum 
percentage to convert. Then, when you click Use Scenarios, the Roth IRA 
Conversion Optimizer appears.  

Step 4: Using the Calculations 
Quick Conversion creates three conversion scenarios: 

• No Conversion to the Roth IRA. 

• 100% conversion in (current year): pay taxes from the Other Assets 

• 100% conversion in (current year): pay taxes from the Roth IRA 
 
If you want these three scenarios as Alternatives 1, 2, and 3, then click the Use Scenarios 
button. 

The Roth IRA Conversion Optimizer 
The Roth IRA Conversion Optimizer helps you and your clients visualize the effects of 
partial conversions. This feature calculates the best percentage of the Ordinary IRA that 
plan owners should convert to a Roth IRA. Using the optimized percentage to convert 
gives the highest Net After-Tax Assets for the target year of the analysis. The Roth IRA 
Conversion Optimizer works best when calculating income tax from adjusted growth 
incomes instead of calculating income tax using entered rates. 

Access the Roth IRA Conversion Optimizer 
On the Quick Calcs menu, click Roth IRA Conversion Optimizer. The Select 
Alternative dialog box appears.  

Click the Alternative for which you want to find the best percentage to convert. The Roth 
IRA Conversion Optimizer appears. 
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Roth IRA Conversion Optimizer Tab: Table of Inputs 
 

Input  Description 
Assumptions Based upon the Birth Dates that you enter in the Main Inputs, 

the program calculates the assumed years of death for the 
owner and the beneficiary. 

Conversion Year Enter the year that the conversion will occur. 
Year for Maximum Net 
After-Tax Assets 

The amount to convert is based on the year in which the owner 
wants to have the maximum Net After-Tax Assets. Enter the 
year. 

Optimization Precision The program converts the fund in 1, 2, 5, or 10 percent 
increments until it finds the optimum percent to convert. 
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 Chapter 11 
Modeling Adjustments to Other Assets 

Other Assets Section        
The Other Assets fund represents all assets that are not part of the Pension Fund or Roth 
IRA. In many cases, an Other Assets fund contains a liquid and a non-liquid balance. The 
program allows you to separately enter these balances, their growth rates, and the tax 
rates on the growth. The liquid balance of the Other Assets fund grows at the rate you 
specify in the Main Inputs section, and the growth is taxed at the rate you specify in the 
Taxes section. The non-liquid balance grows at the rate that you specify in the Other 
Assets section. The program does not tax the growth of the non-liquid balance.  
By default, the program reinvests minimum distributions in the Other Assets fund. You 
can choose to consume, or spend, the minimum distribution by using the Input 
Assumptions window. You can also enter positive or negative adjustments that reflect 
any additional contributions to or withdrawals from the Other Assets fund. Money 
withdrawn from the Other Assets is considered “consumed”—it leaves the analysis 
completely.  
 
Other Assets Section: Table of Inputs 

 
Input  Description 
Description (top) In this box, enter a short description of the Pension Fund. The 

description is optional. 
Total 12/31/(previous 
year) Balance 

Enter the total balance of the Other Assets fund. This includes 
the non-liquid portion. If you’ve entered 

Non-Liquid Portion 
Balance 

Enter the non-liquid portion of the Other Assets balance in this 
box. The program does not tax the Non-Liquid portion. You 
can also enter a growth rate for the Non-Liquid portion. 

Growth Enter the annual percent increase of the Non-Liquid Portion of 
the Other Assets Balance. 

Description Enter a short description for each distribution. The description 
is optional. 

Adjustment Enter the amount of each Adjustment in this box. 
Growth Rate Enter the annual percent increase of the Adjustment. 
From/To Boxes Use these boxes to enter the span of years for which the 

distribution is needed. 
Apply to Alternative These numbers represent the Alternatives. Selected check 

boxes indicate which Alternatives will include the distribution. 
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Apply Growth from (first 
year of analysis)(instead 
of “From” Year) 

In general, you’ll be planning future adjustments, so you’ll 
probably want to adjust for inflation. By default the program 
applies the growth rate on the adjustment from the first year of 
analysis instead of from the first year that the plan owner needs 
the adjustment. This ensures that when the adjustment occurs, 
the program has adjusted it for inflation. 

Custom Adjustments Click this button to enter adjustments on a year-by-year basis 
instead of over a span of years. The program adds these 
adjustments to any adjustments that you enter in the Other 
Assets section. For more information on Custom Data Entry, 
see Chapter 15, Custom Data Entry. 

% of Growth to Realize 
You can model your cases to display the effect of unrealized capital gains. For example, 
if you want to model a case with gains realized only every five years, enter 0% for four 
years followed by 100% in the fifth year. This applies the Other Assets income tax 
growth rate to the realized growth balance in the fifth year. When the Percent of Other 
Assets Growth Realized value is other than 100%, the Other Assets report is changed to 
show the Realized and Unrealized Growth balances.
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Chapter 12 
Modeling Contributions 

Contributions Section 
Use the Contributions section to add contributions to a Pension Fund, Roth IRA, or Other 
Assets. Contributing to a deductible IRA causes tax savings. In order to compare the 
traditional and Roth IRAs, the program can add this tax savings to the plan owner’s Other 
Assets. The program will calculate the tax savings of each contribution by multiplying 
the contribution amount by the income tax rate and adding that amount to the Pension 
Fund. 
 
Plan owners filing single whose AGIs are under $95,000 and joint filers whose AGIs are 
under $150,000 can make nondeductible contributions of up to $2000 annually to Roth 
IRAs. This includes plan owners who’ve attained age 70½. Contributions to Roth IRAs 
won’t be available to higher-income taxpayers, however.  
 
Contributions Section: Table of Inputs 

 
Input  Description 
Contributions Options Click each Alternative for which tax savings will be added to 

the Other Assets fund (due to Pension Fund contributions). 
Target Fund Click in this box and select the fund that will receive the 

contribution. 
Annual Contribution Enter the annual amount of each contribution. 
Growth Rate Enter the annual percent increase of the contribution. 
From Year/To Year Use these boxes to enter the span of years for which the 

contribution is needed. 
Apply to Alternative These numbers represent the Alternatives. Selected check 

boxes indicate which Alternatives will include the 
contribution. 

Apply Growth from (first 
year of analysis)(instead 
of “From” Year) 

In general, you’ll be planning future contributions, so you’ll 
probably want to adjust for inflation. By default the program 
applies the growth rate on the contribution from the first year 
of analysis instead of from the first year that the plan owner 
needs the contribution. This ensures that when the contribution 
occurs, the program has adjusted it for inflation. 
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Custom Adjustments Click to Other Assets, to Roth IRA, or to Pension Fund to enter 
contributions on a year-by-year basis instead of over a span of 
years. The program adds these contributions to the 
contributions that you enter in the Contributions section. 
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Chapter 13 
Modeling Insurance 

Insurance Section 
Use the Insurance section to enter Life Insurance Premiums and 2nd-to-Die Life Insurance 
Proceeds. You can enter premiums and proceeds over a number of years or for specific 
years. The program ignores any proceeds or premiums that occur after the year in which 
second-to-die becomes deceased. 

Insurance Outside Estate? 
This question appears at the top of the insurance section. For each alternative you select if 
the insurance is part of the estate. 

Premiums 
If a dollar amount is entered for the desired distribution, the program increases the 
distribution enough to pay the Insurance Premium without decreasing the after-tax 
amount of money received from the entered distribution. In all other cases, the program 
will distribute the greater of the desired distribution and the amount necessary to pay for 
the Insurance Premium. Life insurance premiums are paid first out of income.  

 
Premiums Tab: Table of Inputs 

 
Input  Description 
Pay Premiums From Select a fund as the primary source for paying the premiums. If 

there is not enough money in the fund you select, the program 
takes the payments first from the Other Assets fund, then from 
the Pension Fund, and finally from Roth IRA. Money used for 
premiums is considered “consumed;” it is not transferred to 
Other Assets. It is completely taken out of the analysis.  

Description Enter a short description for each premium. The description is 
optional. 

Premiums Enter the amount of each Premium in this box. 
Growth Rate Enter the annual percent increase of the Premium. 
From/To Boxes  Use these boxes to enter the span of years for which the 

Premium is needed. 
Apply to Alternative These numbers represent the Alternatives. Selected check 

boxes indicate which Alternatives will include the Premium. 
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Apply Growth from (first 
year of analysis)(instead 
of “From” Year) 

In general, you’ll be planning future Premiums, so you’ll 
probably want to adjust for inflation. By default the program 
applies the growth rate on the Premium from the first year of 
analysis instead of from the first year that the plan owner needs 
the Premium. This ensures that when the Premium occurs, the 
program has adjusted it for inflation. 

Custom Insurance 
Premiums 

Click this button to enter Premiums on a year-by-year basis 
instead of over a span of years. For more information on 
Custom Data Entry, see Chapter 15, Custom Data Entry. 

Proceeds 
For each Alternative, you can choose to include Insurance Proceeds in the taxable estate 
or keep them outside of the estate. In either case, the program adds the Proceeds to the 
Other Assets using the following model: 
 
If proceeds are outside of the estate, the program adds them to the Other Assets on 12/31 
in the year of second-to-die. If the proceeds are inside of the estate, the program adds 
them to the Other Assets on 1/1 of the year after the second-to-die. In both cases, the 
program pays the estate taxes from the Other Assets on 1/2 of the year after the second-
to-die. 
 
Proceeds Tab: Table of Inputs 

 
Input  Description 
Primary Source for Life 
Insurance Premiums 

Select a fund as the primary source for paying the premiums. If 
there is not enough money in the fund you select, the program 
takes the payments first from the Other Assets fund, then from 
the Pension Fund, and finally from Roth IRA. Money used for 
premiums is considered “consumed;” it is not transferred to 
Other Assets. It is completely taken out of the analysis.  

Description Enter a short description for each Proceed. The description is 
optional. 

Proceed Enter the amount of each Proceed in this box. The program 
adds insurance Proceeds to the Net After-Tax Assets every 
year up to and including the year of the second-to-die in an 
owner/spouse case.  

Growth Rate Enter the annual percent increase of the Proceed. 
From/To Boxes  Use these boxes to enter the span of years for which the 

Proceed is needed. 
Apply to Alternative These numbers represent the Alternatives. Selected check 

boxes indicate which Alternatives will include the Proceed. 
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Apply Growth from (first 
year of analysis)(instead 
of “From” Year) 

In general, you’ll be planning future Proceed, so you’ll 
probably want to adjust for inflation. By default the program 
applies the growth rate on the Proceed from the first year of 
analysis instead of from the first year that the plan owner needs 
the Proceed. This ensures that when the Proceed occurs, the 
program has adjusted it for inflation. 

Custom Insurance 
Premiums 

Click this button to enter Proceeds on a year-by-year basis 
instead of over a span of years. For more information on 
Custom Data Entry, see Chapter 15, Custom Data Entry. 
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Chapter 14 
Modeling Donee Exclusion Gifting 

Gift Fund Section 

Gift Fund Section: Table of Inputs 
 

Input  Description 
Gift Fund Options Enter a separate Growth Rate for the Gift Fund. Each 

Alternative can have a different Growth Rate. Click a box and 
select the fund from which contributions will be made. 

Description Enter a short description for each Contribution. The description 
is optional. 

Contribution Enter the amount of each Contribution in this box.  
Growth Rate Enter the annual percent increase of the Contribution. 
From/To Boxes  Use these boxes to enter the span of years for which the 

Contribution is needed. 
Apply to Alternative These numbers represent the Alternatives. Selected check 

boxes indicate which Alternatives will include the 
Contribution. 
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Money that plan owners contribute to the Gift Fund is only taxed if it is coming from the 
Pension Fund. The Gift Fund grows at the rate you specify, and it is not subject to estate 
taxes upon the owner’s death. When the plan owner dies, the program adds the value of 
the Gift Fund to the Net After-Tax Assets. 

 

 

 
 
 
 
 
 
 
 
 
 
 

Apply Growth from (first 
year of analysis)(instead 
of “From” Year) 

In general, you’ll be planning future Contributions, so you’ll 
probably want to adjust for inflation. By default the program 
applies the growth rate on the Contribution from the first year 
of analysis instead of from the first year that the plan owner 
needs the Contribution. This ensures that when the 
Contribution occurs, the program has adjusted it for inflation. 

Custom Insurance 
Premiums 

Click this button to enter Contribution on a year-by-year basis 
instead of over a span of years. For more information on 
Custom Data Entry, see Chapter 15, Custom Data Entry. 
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Chapter 15 
Custom Data Entry 

Custom Data Entry Window 
Use the Custom Data Entry window to make additional data entries to various input 
sections of the program. Using the Custom Data Entry window, you can enter values for 
specific years instead of over a span of years. Also, you can quickly copy or clear 
columns of data from one Alternative to others by using the Fill button, the Copy Col. 
button, and the Clear button.  

Enter Data in the Custom Data Entry Window 
Click  wherever you see it in the program. A Custom Data Entry Window appears. 

For each Alternative, enter an amount or percentage (depending on your purpose) for 
each year. For appropriate sections, values under 100 will be entered as percents 

Clear Button 
Use the Clear button to delete data from Alternatives.  

While in the Custom Data Entry window, click the Clear button or press F7. The Clear 
Inputs window appears. 

Click the Alternatives from which you want to delete data. 

Click the Clear Inputs button. 

Note 
Clicking the Clear button in the Custom Data Entry Window does not have the same effect as clicking the 
Clear Inputs command on the Edit menu. Clicking the Clear button in the Custom Data Entry window only 
affects data in the Custom Data Entry window. 

Copy Col. Button 
Use the Copy Col. button to transfer data from one Alternative to another within the 
Custom Data Entry window. 

Click the Copy Col. button or press F4. The Copy Inputs window appears. 

In the Copy From box, click the Alternative you want to copy. 

In the Copy To box, click the Alternative(s) you want to copy data to. 

Click the Copy Inputs button. 
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Fill Button 
You can use the Fill button to Replace, Add, or Subtract data from one Alternative or all 
of the Alternatives within the Custom Data Entry window.  
 

Click the Fill button. 

In the Annual Amount box, enter the amount that you want to enter into the entire 
column. 

In the Annual Increase in Amount box, enter the rate at which the Annual Amount will 
increase each year. 

Enter the span of years that the Annual Amount includes. 

In the Select the Alternatives to Change group box, click the Alternatives that the 
Annual Amount will affect. Skip this step if you are working with Living Expenses. 

 Click one of the following items: 

Replace—The program overwrites the existing values with the Annual Amount. 

Add—The program combines the data in the Fill window with the existing 
values. 

Subtract—The program decreases the existing values by the Annual Amount. 
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Chapter 16 
Viewing Results 

Current Report 
The Current Report appears at the bottom of the window. It shows a brief view of the 
results for the Current Report and Alternative. Above the Current Report, you can see the 
title of the report and the Alternative for which the results are shown. For example, when 
you open the program, the Summary Report for Alternative 1 appears. You can display 
different reports and Alternatives in the Current Report. 
The Current Report title displays the report name and the Alternative for which the 
results apply. When you open the program, the Summary Report displays the results for 
Alternative 1.  
 

Display a Different Alternative in the Current Report 
Right-click in the Current Report. A short-cut menu appears. 

Click the Alternative for which to display results. The Current Report title displays the 
selected Alternative number. 

-Or- 

• Click  to move through the Alternatives in a descending order. 

• Click  to move through the Alternatives in an ascending order. 
 
 

Expanded Report 
The expanded report appears in a new full-sized window. The title of the report and the 
Alternative for which the results are displayed appear below the Menu bar. If you have 
included more than one Alternative, tabs for each Alternative appear at the bottom of the 
window. Click each tab to view expanded reports for each Alternative. 
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Expand Current Report 
A report always appears at the bottom of the window. You can expand this report to fit 
your entire screen. 

Right-click in the Current Report. A short-cut menu appears. 

Click Expand to Full Screen. The Pension & Roth IRA Analyzer Reports window 
appears. 

-Or- 

• On the Reports menu, click Expand Current Report. 

-Or- 

• Click the Expand Report button in the Reports section. 

Select a Report in Expanded View 
While in Expanded View, click the Reports menu or Graphs menu. A submenu appears. 

Point to Analysis to see list of analysis reports. Point to Comparisons to see a list of 
comparison reports. 

Click the report or graph to view. 

Options Menu in Expanded View 
The expanded report window has its own Options menu that allows you the following: 

• To view the results in Actual or Inflation Adjusted Dollars. 

• To view the graphs in three dimensions. 

• To print graphs and reports from expanded view. 

• To exit the expanded view.                                                                                                                      
 

Reports Section 
Use the Reports section to select the reports that you want to view. The Reports section 
uses tabs to list the Recommended, Analysis, Comparison, and Custom reports. When 
selected, tabs are highlighted in yellow. Selecting a report in the Reports section displays 
a brief description of the Report at the bottom of the window. Double click the report to 
expand it. 

Selecting a Report 
When you’re finished entering your data, click the Reports button on the left side of the 
screen. The Reports section appears. The Reports section contains a number of 
Recommended, Analysis, Comparison, and Custom reports. Next, ask yourself what 
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exactly it is that you want to see. For example, you may want to see the effects of a 
distribution from the Pension Fund to the Other Assets. With that in mind, click the 
Analysis tab in the Reports section. Scroll through the list until you find a report that you 
think might answer your question. Possibly, the Pension Fund Analysis or the Other 
Assets Growth Analysis can answer your question. 

Analysis Reports 
If an entire column displays all zeroes in an Analysis report, then the column and its 
header do not appear in the report. A description of the selected report appears below the 
box.  For details of each report, see Chapter 22, Report Listing. 
 

• Distributions Breakdown Report 

• Donee Exclusion Gifting Analysis 
Report 

• Estate Analysis Report 

• Insurance Analysis Report 

• Life Expectancies Analysis Report 

• Minimum Distributions Life 
Expectancy Analysis Report 

• Minimum Distributions Report 

• Other Assets Analysis Report 

• Other Assets Growth Analysis 
Report 

• Pension Fund Analysis Report 

• Pre-59½ Distributions Analysis 
Report  

• Roth IRA Analysis Report  

• Roth IRA Distributions Report  

• Roth IRA Taxes and Penalties  

• Summary Report  

• Taxable Amount of Pension Fund 
Report  

• Taxable Estate Analysis Report  

• Total Funds Ending Value Report  

• Total Pension & IRA Distributions 
Report  

Comparison Reports 
The Comparison reports and graphs compare values for the Alternatives and show the 
percentage difference between them. If an entire column displays all zeroes, then the 
column and its header do not appear in the report. For a printed list of the report values 
and their descriptions, see the User Manual. 
 

• Cumulative After-Tax Distributions 

• Cumulative Net Proceeds  

• Net After-Tax Assets  

• Other Assets Ending Value  

• Pension Fund Ending Value  

• Roth IRA Distributions  

• Roth IRA Ending Value  

• Total Funds Ending Value  
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• Pension Fund Distributions  • Yearly After-Tax Distributions  
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Chapter 17 
Designing a Report 

Report Designer 
You may find that our pre-designed reports just don’t provide you with the results that 
you need. The Report Designer allows you to create your own reports using all of the 
program’s calculated results.  
 
Report Designer: Window Description 

 
Object/Input  Description 
Analysis Report Title Type the name of the report that you are constructing. If you 

are modifying a report, the report’s name appears here. 
Select Report Button Click Select Report to modify an existing report. 
Available Values The Report Designer lists all of the program’s results in the 

Available Values box. When an Available Value is 
highlighted, a description of the value appears below the box. 
Use the Available Values to create your own report by clicking 
each value and dragging it into the Constructed Report box. 
Click Save Report, Save Graph, or Save Comparison to save 
your Constructed Report. 

Note 
The program can only compare one value at a time. To create a 
Comparison Report, you can only have one value in the Constructed 
Report box 

 
Constructed Report The Constructed Report box lists all of the Available Values 

that you select. Click Save Report, Save Graph, or Save 
Comparison the list as a report. Click Clear to clear the 
Constructed Report box. 

Clear Button This button clears the Constructed Report box. Clicking Clear 
does not delete the report. To delete a report, click Erase 
Report. 

Save Graph Button Click this button to save the Constructed Report as a graph. 
Save Report Button Click this button to save the Constructed Report. 
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Create Comparison 
Button 

Click this button to create a Comparison Report. You can only 
create a comparison of one Available Value. If you have 
multiple values in the Constructed Report box, you cannot 
create a comparison. 

Erase Report Button Click this button to erase the selected report. 

Construct a Report 
1. On the Reports menu, click Report Designer. The Report Designer window 

opens. 

2. In the Analysis Report Title box, type a name for the new report or graph. 

3. In the Available Values list box, click the results to include in the report or graph. 
You can only click one result at a time. A description of each value appears at the 
bottom of the window. 

4. Click the arrow pointing right. The values you clicked appear in the Constructed 
Report list box. 

5. Click the Save Report, Save Graph, or Create Comparison (Report) button. A 
prompt appears. 

Modify an Existing Report 
1. In the Report section, click the Customize button. Or on the Reports menu, click 

Report Designer.  

2. In the Report Designer window, click the Select Report button. The Analysis 
Report Selection window appears. 

3. Click the report or graph to modify. 

4. Click the Select Report button. The results of this report or graph appear in the 
Constructed Report list box in the Report Designer window. 

5. In the Analysis Report Title box, enter a name for the new report or graph. 

6. Add or clear results from the report or graph. 

7. Click the Save Graph or Save Report button. A prompt appears. 

8. Click OK. 

Clear the Constructed Reports Box 
In the Constructed Report box, click the results that you do not want in the report or 
graph. You can only click one at a time. 

Click the arrow pointing left. The values no longer appear in the Constructed Report 
box. 
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Note 
To clear all results from the Constructed Reports box, click the Clear button below the box. When clearing 
results from the Constructed Reports box, the results are not deleted. They are transferred back to the 
Available Values. 

Delete a Report 
1. In the Report Designer window, click the Select Report button. The Analysis 

Report Selection window appears. 

2. From the list, click the report or graph you want to delete. You cannot delete the 
program’s default reports and graphs. 

3. Click the Select Report button. The results of the selected report appear in the 
Constructed Reports list box in the Report Designer window. 

4. Click the Erase Report button. A prompt appears. 

5. Click Yes. 

Note 
You cannot delete the program’s default reports and graphs. 
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Chapter 18 
Applying Report Options 

Report Options Window 
The Report Options window allows you to format your reports for printing. You can 
access the Report Options window via the Reports menu or from within the Print 
window. 

Print the Date and Time 
• Under the Printing Options heading in the Report Options window, click the 

Print Date Prepared and the Print Time check boxes. To print the date 
prepared, you must enter the date in the Client Info section. 

Print in Black and White 
• Under the Printing Options heading in the Report Options window, click the 

Print in Black and White check box. 

Print for Windows NT 
• Under the Printing Options heading in the Report Options window, click the 

Windows NT Printing check box. 

Number Pages 
• Under the Printing Options heading in the Report Options window, click the 

Number Pages check box. 

Format the Text of a Report 
Under the Fonts heading in the Report Options window, click the text you want to 
format. 

The Font dialog box appears. 

Click the Font, Style, Size, and Effects to apply to the text and click OK.  

Notice the description of the text in the Report Options window has changed. 
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Format Page Margins 
• Under the Page Margins heading in the Report Options window, enter the Top, 

Left, Bottom, and Right margin settings (in inches).  

Create a Heading for a Report 
In the Report Options window, click the Heading box. 

Type the text that you want to display at the top of your printed report. 

Include the Heading on a Printed Report 
• Under the Printing Options heading in the Report Options window, click the 

Print Heading check box. 

Limit the Number of Years to Include in a Report 
• Under the Printing Options heading in the Report Options window, enter the 

number of years that you want to include in your reports in the Years to Include 
in Report box. By default, the program includes 60 years of results. 
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Chapter 19 
Printing Reports and Graphs 

Print Window 
Use the Print window to select the reports and graphs you want to print. You can print the 
program’s default Report Groups or its individual Analysis and Comparison reports. You 
can create and print your own Report Groups or a combination of your Report Groups 
and the program’s.  
 
Object/Input  Description 
Available Reports This section contains all of the reports that you can print, 

including your custom reports. The Available Reports box 
displays three tabs: Report Groups, Analyses, and 
Comparisons. Click these tabs to select the different types of 
reports. Click a report to select it. Then drag it into the 
Selected Reports box.  

Report Groups Tab A Report Group is any number of Selected Reports that has 
been combined or grouped. For example, the default Report 
Group, Analysis Graphs, contains the program’s three 
analysis graphs. Selecting a Report Group saves you from 
scrolling through the Available Reports and selecting 
individual reports to print. By default, the program lists six 
Report Groups. 

Analyses Tab The Analyses tab lists all of the program’s analysis reports 
and graphs. 

Comparisons Tab The Comparisons tab lists all of the program’s comparison 
reports and graphs. 

Selected Reports The Selected Reports box displays all of the reports that you 
have selected to print. If you are including all four 
Alternatives in your analysis, four numbered check boxes 
representing the Alternatives will be selected when you open 
the Print window. You can read this as, “The Inputs Report 
for Alternatives 1, 2, 3, and 4 are selected to print.” To 
remove a report from the Selected Reports box, drag the 
report into the Available Reports box.  

Clear Selected Button Click this button to clear all Selected Reports. 

Create Report Group 
Button 

Click this button to create a group of reports that you 
frequently print. 
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Printing Options This section allows you to include a number of Printing 
Options. Click the check boxes to include the options. You 
can include additional Printing Options in the Report Options 
window. 

Print Report Button Click this button to print all Selected Reports.  

Print to File Button The program allows you to save files as text or spreadsheet 
files, so you can edit your files in any word processor or 
spreadsheet program. 

Printer Setup Button Click this button to change printers or to setup another 
printer. 

Report Options Button Click this button to open the Report Options window in 
which you can format your reports. 

Close Button To exit the Print window after you print your reports, click 
Close. 

Help Button Click this button if you need help using the Print window. 

Report Groups 
A Report Group is any number of Selected Reports that has been combined or grouped in 
the Print window. For example, the default Report Group, Analysis Graphs, contains the 
program’s three analysis graphs. Selecting a Report Group saves you from scrolling 
through the Available Reports and selecting individual reports to print. By default, the 
program lists six Report Groups. If you find that you often print the same group of 
reports, you can create your own report group. 

Create a Report Group 
In the same manner that you select reports to print, use the Analyses and Comparisons 
tabs in the Print window to add reports to the Selected Reports box.  

Click the Create Report Group button. 

In the New Report Group dialog box, enter a name for your Report Group and click 
OK. The name of your Report Group now appears on the Report Groups tab in the 
Available Reports box. 

Delete a Report Group 
On the Report Groups tab in the Available Reports box, click the Report Group you 
want to delete. 

Press the Delete key on your keyboard. A warning appears. 

To delete the Report Group, click OK. 
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Save a File as a Text or Spreadsheet File 
1. On the File menu click Print. Or on the toolbar, click the Print graphic. The 

Print Report window opens. 
2. Click the Print to File button. The Print to File window opens. 
3. Select from one of four file types, which you can edit or send as e-mail 

attachments: 
a. Text file: saves the file with a .txt extension, which can be opened in any 

word processor 
b. Spreadsheet file: saves the file with a WK1 extension, which can be opened 

in Excel, Lotus, or Quattro Pro 
c. HTML: saves the file with an .html extension, which is used most commonly 

on the Internet but can be read by most word processors 
d. DOC: if you have Microsoft Word 97 or later, saves the file with a .doc 

extension, which can be opened in Word 

4.  Click the Create File button. The Save As window opens. Enter a file name and 
specify a directory to which the file should be saved.  
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Chapter 20 
Frequently Asked Questions 

 
We’ve been taking notes from our tech support calls, and we’ve developed a list of 
frequently asked questions. Here they are: 

• How do the New Rules for minimum distributions work? 

• How do I create an analysis?  

• How do I model a spousal rollover?  

• Can I choose any method of calculating life expectancies?  

• How does the program handle the MDIB requirements?  

• Why are the Net After-Tax Assets larger than the Total Funds Ending Value?  

• Why are the Unpaid Roth IRA Taxes so high?  

• Why did the Other Assets balance appear/change?  

• What are the best reports to show my clients?  

How do the New Rules for Minimum Distributions Work? 

Required Minimum Distributions: 
Calculations under the Final Regulations 
After more than a decade of proposed regulations, final minimum distribution regulations 
were published on April 17, 2002. These new rules are based primarily on the proposed 
regulations of 2001, but they do add some new calculation wrinkles to consider. 
As with the 2001 proposed regulations, the final regulations keep the basic calculation 
intact. Each year, the distribution is calculated by dividing the previous year’s ending 
balance by a life expectancy number. The calculation complexity lies in determining the 
life expectancy number.  
 
Here’s how the new rules work: 
 
Situation I: Owner still alive 
If the owner is still alive, the life expectancy is taken straight from the Uniform Lifetime 
Table. Simply find the owner’s age on the table (it covers ages 70 through 115), and use 
the life expectancy listed. For this situation, the only change caused by the 2002 final 
regulations was to update the numbers in the Uniform Lifetime Table. 
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Prior to 2001, the Uniform Lifetime Table was known as the MDIB table, and was used 
only for nonspousal beneficiaries. Now, it is used whenever the owner is alive, making 
the distribution calculation very straightforward. There is only one exception to this rule: 
cases involving spousal beneficiaries who are more than ten years younger than the 
owner. In that case, the joint life expectancy of the owner and spouse is used. Once the 
owner dies, this exception no longer applies, and Situation 4 (see below) applies. 
 
Situation 2: Owner dies with no beneficiary 
In the year of death, the minimum distribution is still calculated according to Situation 1 
(above). It’s only in the years after the owner’s death that this situation applies. 
If the owner dies before the required beginning date, and there is no beneficiary alive as 
of the owner’s death, the five year rule applies—all the money has to be distributed 
within five years of the year the owner died. 
 
If the owner dies on or after the required beginning date, and there is no beneficiary alive 
as of the date of death, distributions after the owner’s death are taken over a term based 
on the owner’s life expectancy in the year of death. This calculation is easier than it 
sounds. For the year after death, subtract one from the owner’s single life expectancy in 
the year of death. As each year passes, reduce the life expectancy by one. For example, if 
the owner died in 2003, the distribution in 2004 would be based on the owner’s 2003 life 
expectancy minus one. 
 
The new life expectancy tables used by the 2002 final regulations add some complexity 
to cases when the owner has already died. If distributions are being taken under this 
scenario, the length of the term has to be recalculated using the 2002 single life 
expectancy table. For example, if a plan owner died in 1995, the 2003 distribution would 
be based on the owner’s life expectancy (using the new table) in 1995 reduced by 8. 
Under the 2001 proposed regulations, the beneficiary had to be alive as of 12/31 of the 
year following the owner’s death to be considered valid. Under the 2002 regulations, the 
beneficiary only has to be alive when the owner dies to be considered.  
 
Situation 3: Owner dies with nonspousal beneficiary 
In the year of death, the minimum distribution is still calculated according to Situation 1 
(above). It’s only in the years after the owner’s death that this situation applies. 
When the owner dies with a nonspousal beneficiary, a term certain distribution period is 
established based on the designated beneficiary’s single life expectancy in the year after 
the owner’s death. Unlike Situation 2, in this case the term is based on a life expectancy 
calculated in the year after the owner’s death, rather than the year of death. For example, 
if the owner died in 2003, the life expectancy used as the divisor in 2004 would be the 
beneficiary’s single life expectancy in 2004. In 2005, the divisor used would be 2004’s 
number minus 1. The life expectancy in the year after death is, of course, calculated using 
the new single life expectancy table, and, as with Situation 2, an existing term certain 
would have to be recalculated using the new table. 
 
The 2002 final regulations add another wrinkle to those situations when the owner died 
on or after the required beginning date. In these situations, the life expectancy used is the 
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greater of the one calculated using the “no beneficiary” case (situation 2), and the one 
resulting from the calculation described in the previous paragraph. This can get a little 
confusing, because the “no beneficiary” case starts with a term calculated in the year of 
death, while the nonspousal beneficiary’s term certain starts the year after the owner’s 
death. 
 
Situation 4: Owner dies with spousal beneficiary 
In the year of death, the minimum distribution is still calculated according to Situation 1 
(above). It’s only in the years after the owner’s death that this situation applies. 
When the owner dies with a spousal beneficiary, the spouse gets special treatment. In this 
case, the distributions are based on the spouse’s single life expectancy recalculated each 
year after the owner’s death. If the owner dies prior to the calendar year in which he 
would have reached age 70½, the spouse does not have to start taking distributions until 
that year. Upon the spouse’s death, the distributions become term certain, with the term 
set to the spouse’s life expectancy in the year of death. This works the same as the old 
term certain method, with the life expectancy being reduced by one for each year that 
passes after the spouse’s death. 
 
As with situation 3, the 2002 final regulations add more complexity. For cases where the 
client dies on or after the required beginning date, the life expectancy used is the greater 
of the one calculated using the “no beneficiary” case (situation 2), and the one resulting 
from the calculation described in the previous paragraph. 
 
When do these apply? 
In 2002, there is the option of using either the pre-2001 proposed regulations (with all 
their calculation and recalculation options), the 2001 proposed regulations, and the 2002 
final regulations. After 2002, only the 2002 final regulations may be used.  
The 2002 final regulations added more than just a new mortality table to these 
calculations. They also added complexity. When all the different situations listed above 
are taken together, they represent a fairly complicated set of calculations that have to be 
correctly performed to make sure you calculate the correct distribution for your clients.  
 2002, Brentmark Software, Inc. All Rights Reserved. 

Calculating Required Minimum Distributions using the 2001 Proposed 
Regulations: 
The regulations released on 1/11/2001 radically changed the way minimum distributions 
have to be calculated. They eliminated a lot of complexity reduced the number of 
decisions made by a plan owner. These regulations eliminated the old recalculation 
options. There is no "hybrid method" or "joint term certain method." However, the new 
methodology does still have some similarities to the old. For example, the distribution is 
still calculated by dividing the previous year's balance by a life expectancy number. 
 
Here’s how it works: 
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Situation 1: Owner still alive 
If the owner is still alive, the distributions are based on the divisor found in the MDIB 
table for owner’s age. The MDIB table is a published table of joint life expectancies for 
an owner and a beneficiary who is ten years younger than the owner. It simplifies the 
calculation to only using the owner’s age. No beneficiary information is needed, and no 
recalculation options are available. There is only one exception to this rule – for cases 
involving spousal beneficiaries that are more than ten years younger than the owner. 
 

Situation 2: Owner dies with nonspousal beneficiary 
When the owner dies with a nonspousal beneficiary, a term certain distribution period is 
established, based on the designated beneficiary's single life expectancy in the year after 
the owner’s death. As with the old term certain method, this life expectancy is simply 
reduced by one for each year after it is calculated. 
 

Situation 3: Owner dies with no beneficiary 
This is the only situation where the owner’s required beginning date is relevant. If the 
owner dies before the required beginning date, and there is no beneficiary alive as of 
12/31 of the year following the owner's death, the five year rule applies – all the money 
has to be distributed within the next five years. 
If the owner dies after the required beginning date, and there is no beneficiary alive as of 
12/31 of the year following the owner’s death, the distributions are taken out over a term 
based on the owner’s life expectancy in the year of death. Once again, this works the 
same as the old term certain method, with the life expectancy being reduced by one for 
each year that passes after the owner’s death. 
 
Situation 4: Owner dies with spousal beneficiary 
When the owner dies with a spousal beneficiary, the spouse gets special treatment. In this 
case, required distributions are generally based on the spouse’s single life expectancy in 
each year after the owner’s death.  
 
If the owner dies prior to the calendar year in which he would have reached age 70½, the 
spouse does not have to start taking distributions until that year. However, if the owner 
dies before 12/31 of the calendar year in which he would have reached age 70½ and the 
spouse also dies before 12/31 of the calendar year in which the original owner would 
have reached age 70½, then the second-to-die spouse is treated as the new owner with the 
rules of Situation 2 being applied if the second-to-die spouse has a designated beneficiary 
or Situation 3 if there is no designated beneficiary.  
 
If the spouse dies after the year in which the original owner would have turned 70½, the 
distributions become term certain, with the term set to the spouse’s life expectancy in the 
year of death. Again, this works the same as the old term certain method, with the life 
expectancy being reduced by one for each year that passes after the spouse’s death. 
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Situation 5: Owner dies and a spousal rollover 
When the owner dies with a spousal beneficiary, the spouse has the option of doing a 
spousal rollover with the spouse becoming the new owner.  In such a case, the rules of 
Situation 1 apply after the spouse becomes the new owner.   
 

Situation 6: The Exception to Situation 1 
The exception to situation 1 is when there is a spousal beneficiary who is more than 10 
years younger than the owner. In this case, the life expectancy used while the owner is 
alive is the joint life expectancy of the owner and spouse, recalculated in each year. Once 
the owner dies, the exception no longer applies, and the distribution is handled according 
to the situations described above. 

1987 Proposed Regulations (Pre-2001 Rules) 
If the plan owner has not named a beneficiary 
If the plan owner has not named a beneficiary, then there are two methods for 
determining the plan owner’s life expectancy each year: Term Certain method or 
Recalculation method. Use the Recalculate Owner’s Life Exp. check box to determine the 
method: 
• Term Certain method—Clear the Recalculate Owner’s Life Exp. check box. The 

program uses Table V to determine the owner’s life expectancy in for the 
Required Beginning Date (first year that distributions are required). Thereafter, 
the program subtracts one from the life expectancy each year. 

• Recalculation method—Click the Recalculate Owner’s Life Exp. check box. The 
program uses Table V to determine the life expectancy each year. 

•  

• If the plan owner has named a beneficiary 

• Plan owners and beneficiaries have the ability to recalculate their life 
expectancies annually (see Note). If the plan owner has named a beneficiary, then 
there are actually four methods of recalculating life expectancies each year. Use 
the Recalculate Owner’s Life Exp. and the Recalculate Beneficiary’s Life Exp. 
check boxes to determine the method: 

 

• Joint Recalculation method—Click both check boxes. Both life expectancies are 
recalculated. The program uses Table VI to determine the minimum distribution 
from the life expectancies.  

 

• Joint Term Certain method—Clear both check boxes. Neither life expectancy is 
recalculated. Both the owner and the beneficiary use the term certain method. 
Both life expectancies decrease by 1 annually.  
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• Hybrid method—Only click Recalculate Owner’s Life Exp. The owner's life 
expectancy is recalculated and the beneficiary uses the term certain method. 
Using the beneficiary's deemed age ((determined using single life Table V) and 
the owner's actual age, the program uses joint life Table VI to determine the 
minimum distribution. Many planners recommend this method when the plan 
owner is older than the beneficiary. 

 

• Hybrid method—Only click Recalculate Beneficiary’s Life Exp. The 
beneficiary's life expectancy is recalculated, and the owner uses the term certain 
method. Using the owner's deemed age (determined using single life Table V) and 
the beneficiary's actual age, the program uses joint life Table VI to determine the 
minimum distribution. Planners recommend this variant when the beneficiary is 
older than the plan owner. 

How Do I Create an Analysis? 
The answer to this question depends on what type of analysis you want to create. 
Generally, you want to enter data in the Main Inputs section and create your Alternatives 
first. The program contains a number of other sections that allow you to enter personal 
names of your clients and titles for each Alternative, taxes, living expenses, pension fund 
distributions, Roth IRA conversions and distributions, adjustments to the Other Assets 
fund, contributions, insurance premiums and proceeds, donee exclusion gifting, and 
more.  
 
We’ve received calls concerning a few common types of analyses. We’ve listed these in 
Chapter 24, Sample Cases.  

Can I Choose any Method of Calculating Life Expectancies? 
The answer to this question is yes. For a description of how the program calculates life 
expectancies, see Minimum Distributions Options. 

Why is the Net After-Tax Assets Larger than the Total Funds Ending Value? 
The Net After-Tax Assets value is larger than the Total Funds Ending Value only when 
you have selected Estate Analysis: Max Deferral in the Main Inputs section. When you 
select Estate Analysis: Max. Deferral, the program includes the Present Value of Future 
After-Tax Distributions in the Net After-Tax Assets. 
 
When calculating the Net After-Tax Assets, the program assumes that both the owner and 
the spousal beneficiary (if there is one) have died by the end of each year. In most cases, 
the surviving heir does not have to withdraw the entire balance from the Pension Fund or 
Roth IRA at the time of death. Instead, he or she can let the money grow tax-free or tax-
deferred and withdraw the money according to minimum distribution rules. Often, this 
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growth is over a long period of time because it is based on the heir’s term certain life 
expectancy.  
 
When you select Estate Analysis: Max. Deferral in the Main Inputs section, the program 
includes the value of the deferred growth in the Net After-Tax Assets value. Look at the 
P.V. of Future After-Tax Distributions column in the Estate Analysis report. This column 
lists the present value of all future distributions that will be withdrawn from the Pension 
Fund and/or the Roth IRA. Each of these distributions is net of income tax and present 
valued back to the date of death using the Inflation Rate that you entered in the Main 
Inputs section. In turn, the program calculates the Net After-Tax Assets using the 
following formula: 
Net After-Tax Assets = P.V. of Future After-Tax Distributions 
+ Distributions to Other Assets 
-  Federal Estate Tax 
-  State Death Tax 
If you have not clicked Estate Analysis: Max. Deferral in the Main Inputs section, the 
report will not include a P.V. of Future After-Tax Distributions column. In such a case, 
the heir withdraws the entire balance of the plan after the death of both the plan owner 
and the beneficiary.  

Why are the Unpaid Roth IRA Taxes so High? 
The Unpaid Roth IRA Taxes column lists all the income taxes that the Roth IRA 
generates in the event that the owner and spousal beneficiary die by the end of each year. 
The values in the column consist of any income tax on the Roth IRA Conversion that has 
not been paid. Since the program assumes that death occurs at the end of the year, the 
Unpaid Roth IRA Taxes value does not include that year’s conversion tax because it has 
already been paid.  
 
If you click Estate Analysis: Max. Deferral in the Main Inputs section, the program 
assumes that the heir will withdraw the balance of the plan over his or her term certain 
life expectancy after the death of the owner and spouse (if there is one). If both the owner 
and the spouse die within five years of a conversion, this any withdrawal may cause 
income tax. The program includes this income tax in the Unpaid Roth IRA Taxes 
column.  

Why did the Other Assets Balance Appear/Change? 
By default, the program reinvests minimum distributions in the Other Assets fund. If you 
want to model a case in which minimum distributions are spent, see Input Assumptions. 
Also, you may have instructed the program to pay Roth IRA conversion taxes from the 
Other Assets. If the Other Assets fund did not have enough money to pay the taxes, the 
program created a balance large enough to do so. 
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What are the Best Reports to Show My Clients? 
We’ve been asked this question so many times that we’ve included what we call our 
Recommended Reports: 

• Summary Report  

• Minimum Distributions Report  

• Estate Analysis Report  

• Comparison of Cumulative Net Proceeds Report  

• Comparison of Net After-Tax Assets Report  

How Do I Include Additional Streams of Income? 
The Pension & Roth IRA Analyzer allows you to include taxable income, such as an AGI 
or social security benefits, to an analysis. If you want to include an AGI as income, you 
need to enter the AGI as a Taxable Annuity. However, if you’re using an AGI method for 
calculating income taxes, you do not want to enter the AGI in two places. 

What are the Lifetime Required Minimum Distributions Rules? 
The Required minimum distributions rules generally apply when the owner of the plan 
reaches what is known as the age 70½ year. You reach 70½ on the date that is six months 
after your 70th birthday. If you reach age 70 in January through June, that same calendar 
year will be your age 70½-year. If you reach age 70 in July through December, your age 
70½-year will be the year AFTER your 70th birthday. (Only the IRS could come up with 
rules like this!).  

What is the Significance of the Age 70½ Year?  
Generally (which means there are some exceptions), you must make a Required 
Minimum Distribution for the year in which you turn age 70½. The Required Minimum 
Distribution is the result of a simple calculation: you divide the IRA balance from 
December 31st of the preceding year by a Life Expectancy. This determined life 
expectancy is what makes the required minimum distributions rules so complex. The IRA 
distribution rules also depend on whether the owner of the traditional IRA has reached 
what is known as the Required Beginning Date. The Required Beginning Date is April 1st 
of the calendar year following the year in which the owner reaches age 70½. If the owner 
dies before the Required Beginning Date, the distribution rules are different than if he or 
she dies on or after the Required Beginning Date.  
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What is the Significance of the Required Beginning Date? 
If the IRA owner dies on or after his Required Beginning Date, distributions from the 
traditional IRA will be determined by elections he did or did not make. Required 
minimum distributions will be locked-in and will only change due to certain other events 
(such as the death of the owner or beneficiary or a rollover by a surviving spouse). It is 
very important that one’s distribution options be carefully considered before one reaches 
the Required Beginning Date. Many IRA owners will need to consult with a professional 
advisor in order to make the best choice. The Required Beginning Date locks-in one’s 
distributions based on the beneficiary selections. Circumstances such as death may result 
in different beneficiaries later on, but the selections in effect on the Requirement 
Beginning Date will control the amount of those distributions.  
 
Once you have reached the Age 70½ year, you must make a distribution each year (i.e., 
no later than the end of the year) based on the traditional IRA balance as of December 
31st of the preceding year. The rule that allows you to distribute by April 1st of the 
following year is a one-time exception that only applies to the first year.  
The best way to understand this rule is through an example. Let’s assume that an IRA 
owner was born on February 15, 1928. He would be age 70 on 2/15/98. He would be age 
70½ on 8/15/98. His age 70½-year is 1998. He must make a Required Minimum 
Distribution for 1998 by 4/1/99 based on the IRA balance as of 12/31/97. He must also 
make a Required Minimum Distribution for 1999 by 12/31/99 based on his IRA balance 
as of 12/31/98. In 2000, he must make a Required Minimum Distribution by 12/31/00 
based on his IRA balance as of 12/31/99 and so on. In this example, the IRA owner has 
the option of making his 1998 Required Minimum Distribution by 4/1/99 instead of by 
12/31/98. The disadvantage of making the 1998 distribution in 1999 is that he must also 
make a 1999 distribution by 12/31/99. So, if he delays the first Required Minimum 
Distribution until 1999, he will be making two Required minimum distributions in 1999 
and possibly pushing himself into a higher tax bracket. In many cases, he would have 
been better off making the 1998 Required Minimum Distribution in 1998 and the 1999 
Required Minimum Distribution in 1999. Remember, it is only the first Required 
Minimum Distribution that may be delayed until April 1st of the following year. 
For non-spousal beneficiaries, distributions are subject to the MDIB requirements (see 
IRC Proposed Treas. Reg. Sec.1.401 (a)(9)-2). MDIB requires that no (non-spousal) 
distribution that occurs after the Required Beginning Date be less than the one calculated 
by dividing the Plan Balance by the factor from the MDIB Table divisor from IRC 
Proposed Treas. Reg. Sec.1.401 (a)(9)-2, Q-4. Effectively, this requirement is triggered 
when the non-spousal beneficiary is more than ten years younger than the plan owner is 
and will result in a joint life expectancy factor for a person who is ten years younger than 
the owner regardless of the actual age of the beneficiary. The MDIB limitation may be 
removed after the death of the owner if the plan owner previously made a written election 
to that effect before the Required Beginning Date. The program assumes that this election 
has been made. The program handles the MDIB calculation automatically, substituting 
the MDIB Table divisor for the Life Expectancy when appropriate. 
 
Minimum distribution requirements may be changed by the death of the plan owner. In 
the case of non-spousal beneficiaries, this may be caused by the possible removal of 



Chapter 20:  Frequently Asked Questions 

 84 

MDIB requirements. For spousal beneficiary cases, a switch to single life expectancy is 
sometimes possible after the death of the plan owner or spousal beneficiary. A surviving 
spousal beneficiary also has the option of electing to treat the plan as hers (or his) after 
the death of the plan owner. The program assumes a spousal rollover at the time of the 
client's death. 
  
Minimum distributions for a Roth IRA do not start until after the death of the plan owner. 
They are based solely on the life expectancy of the beneficiary. For non-spousal 
beneficiaries, this life expectancy is calculated as of the year after death and reduced by 
one for each year after that. 

How Do I Convert Existing Pre-59 ½ Distributions? 
Revenue Ruling 2002-62 allows for a one-time switch to the Minimum Distributions 
method of calculating pre-59½ distributions. The software allows you to illustrate this 
switch. Enter the date the client started taking distributions as the Starting Date and the 
year of the switch as the Distribution Year. Select Minimum Distributions as the 
Distribution Method. The illustration will start in Distribution Year, illustrating the 
Minimum Distributions method from that year through the end of the calculations. 
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Chapter 21 
Reference Material 

To keep procedures short and free of lengthy discussions, this manual refers to the 
following material. The material is listed alphabetically. 

Beneficiary 
If you have entered names in the Client Info section, click the name of the beneficiary. If 
not, click Spouse, Child, or None.  
 
If plan owners designate a beneficiary, the minimum distribution rules allow plan owners 
to withdraw retirement plan funds over the joint life expectancies of the plan owner and 
the beneficiary. When you include a beneficiary in your analyses, the program uses joint 
life expectancy factors based on the ages of the plan owner and beneficiary. Generally, 
the term beneficiary refers to an individual. If the beneficiary is the spouse of a Roth IRA 
owner, the annual election to recalculate the beneficiary’s single life expectancy after the 
required beginning date is available.  
 
For non-spousal beneficiaries, the life expectancy is calculated once, and it is reduced by 
one for each year after the required beginning date. Non-spousal beneficiaries have 
additional limitations placed on their calculated distributions: 

• A non-spousal beneficiary is not permitted to recalculate his or her life 
expectancy in each year. 

• For minimum distributions, nonspousal distribution calculations are subject to the 
MDIB requirements. 

 
The program automatically handles both of these additional limitations for you. If there is 
more than one person named as the beneficiary (for example, children of the plan owner), 
the age of the beneficiary with the shortest life expectancy must be used to calculate the 
joint life expectancy. 
 
If a charity or the plan owner’s estate is named as the beneficiary, there is no “designated 
beneficiary,” and funds must be withdrawn over the plan owner’s life expectancy. A trust 
can also be named as the beneficiary. Generally in such cases, the life expectancy of the 
trust’s beneficiary can be used to calculate the joint life expectancy. 

Rev. Rul. 2002-62; 2002-42 IRB 1 (3 Oct 2002) 
Part I  
Section 72.--Annuities; Certain Proceeds of Endowment and Life Insurance Contracts 
SECTION 1. PURPOSE AND BACKGROUND  
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.01  The purpose of this revenue ruling is to modify the provisions of Q&A-12 of Notice 
89-25, 1989-1 C.B. 662, which provides guidance on what constitutes a series of 
substantially equal periodic payments within the meaning of § 72(t)(2)(A)(iv) of the 
Internal Revenue Code from an individual account under a qualified retirement plan. 
Section 72(t) provides for an additional income tax on early withdrawals from qualified 
retirement plans (as defined in § 4974(c)).  Section 4974(c) provides, in part, that the 
term “qualified retirement plan” means (1) a plan described in § 401 (including a trust 
exempt from tax under § 501(a)), (2) an annuity plan described in § 403(a), (3) a tax-
sheltered annuity arrangement described in § 403(b), (4) an individual retirement account 
described in § 408(a), or (5) an individual retirement annuity described in § 408(b).  
 
.02 (a) Section 72(t)(1) provides that if an employee or IRA owner receives any amount 
from a qualified retirement plan before attaining age 59½, the employee’s or IRA 
owner’s income tax is increased by an amount equal to 10-percent of the amount that is 
includible in the gross income unless one of the exceptions in § 72(t)(2) applies.    
(b) Section 72(t)(2)(A)(iv) provides, in part, that if distributions are part of a series of 
substantially equal periodic payments (not less frequently than annually) made for the life 
(or life expectancy) of the employee or the joint lives (or joint life expectancy) of the 
employee and beneficiary, the tax described in § 72(t)(1) will not be applicable. Pursuant 
to § 72(t)(5), in the case of distributions from an IRA, the IRA owner is substituted for 
the employee for purposes of applying this exception.  
 
(c) Section 72(t)(4) provides that if the series of substantially equal periodic payments 
that is otherwise excepted from the 10-percent tax is subsequently modified (other than 
by reason of death or disability) within a 5-year period beginning on the date of the first 
payment, or, if later, age 59½, the exception to the 10-percent tax does not apply, and the 
taxpayer’s tax for the year of modification shall be increased by an amount which, but for 
the exception, would have been imposed, plus interest for the deferral period. 
 
(d) Q&A-12 of Notice 89-25 sets forth three methods for determining whether payments 
to individuals from their IRAs or, if they have separated from service, from their 
qualified retirement plans constitute a series of substantially equal periodic payments for 
purposes of § 72(t)(2)(A)(iv).  
 
(e) Final Income Tax Regulations that were published in the April 17, 2002, issue of the 
Federal Register under § 401(a)(9) provide new life expectancy tables for determining 
required minimum distributions. 
 
SECTION 2.  METHODS 
.01 General rule. Payments are considered to be substantially equal periodic payments 
within the meaning of § 72(t)(2)(A)(iv) if they are made in accordance with one of the 
three calculations described in paragraphs (a) – (c) of this subsection (which is comprised 
of the three methods described in Q&A-12 of Notice 89-25).  
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(a) The required minimum distribution method. The annual payment for each year is 
determined by dividing the account balance for that year by the number from the chosen 
life expectancy table for that year. Under this method, the account balance, the number 
from the chosen life expectancy table and the resulting annual payments are redetermined 
for each year. If this method is chosen, there will not be deemed to be a modification in 
the series of substantially equal periodic payments, even if the amount of payments 
changes from year to year, provided there is not a change to another method of 
determining the payments. 
 
(b) The fixed amortization method. The annual payment for each year is determined by 
amortizing in level amounts the account balance over a specified number of years 
determined using the chosen life expectancy table and the chosen interest rate. Under this 
method, the account balance, the number from the chosen life expectancy table and the 
resulting annual payment are determined once for the first distribution year and the 
annual payment is the same amount in each succeeding year.  
 
(c) The fixed annuitization method. The annual payment for each year is determined by 
dividing the account balance by an annuity factor that is the present value of an annuity 
of $1 per year beginning at the taxpayer's age and continuing for the life of the taxpayer 
(or the joint lives of the individual and beneficiary). The annuity factor is derived using 
the mortality table in Appendix B and using the chosen interest rate. Under this method, 
the account balance, the annuity factor, the chosen interest rate and the resulting annual 
payment are determined once for the first distribution year and the annual payment is the 
same amount in each succeeding year.          
 
.02 Other rules.  The following rules apply for purposes of this section.  
(a) Life expectancy tables. The life expectancy tables that can be used to determine 
distribution periods are: (1) the uniform lifetime table in Appendix A, or (2) the single 
life expectancy table in § 1.401(a)(9)-9, Q&A-1 of the Income Tax Regulations or (3) the 
joint and last survivor table in § 1.401(a)(9)-9, Q&A-3. The number that is used for a 
distribution year is the number shown from the table for the employee’s (or IRA owner’s) 
age on his or her birthday in that year. If the joint and survivor table is being used, the 
age of the beneficiary on the beneficiary’s birthday in the year is also used. In the case of 
the required minimum distribution method, the same life expectancy table that is used for 
the first distribution year must be used in each following year. Thus, if the taxpayer uses 
the single life expectancy table for the required minimum distribution method in the first 
distribution year, the same table must be used in subsequent distribution years. 
 
(b) Beneficiary under joint tables. If the joint life and last survivor table in §1.401(a)(9)-
9, Q&A-3, is used, the survivor must be the actual beneficiary of the employee with 
respect to the account for the year of the distribution. If there is more than one 
beneficiary, the identity and age of the beneficiary used for purposes of each of the 
methods described in section 2.01 are determined under the rules for determining the 
designated beneficiary for purposes of § 401(a)(9). The beneficiary is determined for a 
year as of January 1 of the year, without regard to changes in the beneficiary in that year 
or beneficiary determinations in prior years. For example, if a taxpayer starts distributions 
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from an IRA in 2003 at age 50 and a 25-year-old and 55-year-old are beneficiaries on 
January 1, the 55-year-old is the designated beneficiary and the number for the taxpayer 
from the joint and last survivor tables (age 50 and age 55) would be 38.3, even though 
later in 2003 the 55-year-old is eliminated as a beneficiary. However, if that beneficiary 
is eliminated or dies in 2003, under the required minimum distribution method, that 
individual would not be taken into account in future years. If, in any year there is no 
beneficiary, the single life expectancy table is used for that year.  
 
(c) Interest rates. The interest rate that may be used is any interest rate that is not more 
than 120 percent of the federal mid-term rate (determined in accordance with § 1274(d) 
for either of the two months immediately preceding the month in which the distribution 
begins). The revenue rulings that contain the § 1274(d) federal mid-term rates may be 
found at www.irs.gov\tax_regs\fedrates.html.  
 
(d) Account balance. The account balance that is used to determine payments must be 
determined in a reasonable manner based on the facts and circumstances. For example, 
for an IRA with daily valuations that made its first distribution on July 15, 2003, it would 
be reasonable to determine the yearly account balance when using the required minimum 
distribution method based on the value of the IRA from December 31, 2002 to July 15, 
2003. For subsequent years, under the required minimum distribution method, it would 
be reasonable to use the value either on the December 31 of the prior year or on a date 
within a reasonable period before that year’s distribution.  
 
(e) Changes to account balance. Under all three methods, substantially equal periodic 
payments are calculated with respect to an account balance as of the first valuation date 
selected in paragraph (d) above. Thus, a modification to the series of payments will occur 
if, after such date, there is (i) any addition to the account balance other than gains or 
losses, (ii) any nontaxable transfer of a portion of the account balance to another 
retirement plan, or (iii) a rollover by the taxpayer of the amount received resulting in such 
amount not being taxable.  
 
.03 Special rules. The special rules described below may be applicable.  
(a) Complete depletion of assets.  If, as a result of following an acceptable method of 
determining substantially equal periodic payments, an individual’s assets in an individual 
account plan or an IRA are exhausted, the individual will not be subject to additional 
income tax under § 72(t)(1) as a result of not receiving substantially equal periodic 
payments and the resulting cessation of payments will not be treated as a modification of 
the series of payments.   
 
(b) One-time change to required minimum distribution method.  An individual who 
begins distributions in a year using either the fixed amortization method or the fixed 
annuitization method may in any subsequent year switch to the required minimum 
distribution method to determine the payment for the year of the switch and all 
subsequent years and the change in method will not be treated as a modification within 
the meaning of § 72(t)(4). Once a change is made under this paragraph, the required 
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minimum distribution method must be followed in all subsequent years.  Any subsequent 
change will be a modification for purposes of § 72(t)(4). 
 
SECTION 3. EFFECTIVE DATE AND TRANSITIONAL RULES    
 The guidance in this revenue ruling replaces the guidance in Q&A-12 of Notice 
89-25 for any series of payments commencing on or after January 1, 2003, and may be 
used for distributions commencing in 2002.  If a series of payments commenced in a year 
prior to 2003 that satisfied § 72(t)(2)(A)(iv), the method of calculating the payments in 
the series is permitted to be changed at any time to the required minimum distribution 
method described in section 2.01(a) of this guidance, including use of a different life 
expectancy table.  
 
SECTION 4. EFFECT ON OTHER DOCUMENTS 
Q&A-12 of Notice 89-25 is modified.  
 
SECTION 5. REQUEST FOR COMMENTS 
The Service and Treasury invite comments with respect to the guidance provided in this 
revenue ruling.  Comments should reference Rev. Rul. 2002-62.  
Comments may be submitted to CC:ITA:RU (Rev. Rul. 2002-62, room 5226, Internal 
Revenue Service, POB 7604 Ben Franklin Station, Washington, DC 20044. Comments 
may be hand delivered between the hours of 8:30 a.m. and 5 p.m. Monday to Friday to: 
CC:ITA:RU (Rev. Rul. 2002-62), Courier's Desk, Internal Revenue Service, 1111 
Constitution Avenue NW., Washington, D.C. Alternatively, comments may be submitted 
via the Internet at Notice.Comments@irscounsel.treas.gov. All comments will be 
available for public inspection and copying. 
 
Drafting Information  
 The principal author of this revenue ruling is Michael Rubin of the Employee 
Plans, Tax Exempt and Government Entities Division. For further information regarding 
this revenue ruling, please contact Mr. Rubin at 1-202-283-9888 (not a toll-free number).  

Rev. Rul. 2002-62 FAQ 
The IRS published an article on its web site entitled “FAQs regarding Revenue Ruling 
2002-62" (see http://www.irs.gov/retirement/article/0,,id=103045,00.html) that includes 
examples of how to do the pre-59½ distribution calculations. Unfortunately, they used 
some rather unusual assumptions for doing the calculations. 
 
For the Amortization method, the article illustrates a distribution that is taken at the end 
of each year. This is an easy enough calculation to do, except that Rev. Rul. 2002-62 
limits the “reasonable interest rate” by the mid-term rates from the two months prior to 
the first distribution.  Based on this discrepancy, the IRS must be expecting you to guess 
at the interest rate, or they are allowing an "end-of-period" methodology for a distribution 
that starts immediately.   
 



Chapter 21:  Reference Material 

 92 

For the Annuitization method, the article shows an annuity factor that uses the “curtate” 
approach to valuing annuities. This approach is not frequently seen in IRS calculations. 
In the past, the IRS has used the “complete” method for valuing annuities (IRS 
Publication 1457, for example) when using government tables. 
 
The distribution calculations in the FAQ result in higher distribution amounts. The 
software allows you to use the FAQ's methodology—just select “Rev. Rul. 2002-62 
FAQ.”  When you have made this selection, the annuitization method will use the 
“curtate” method of valuing annuities, and the amortization method will use the "end-of-
period" method (even though the distribution is assumed to start immediately). 

IRS Notice 89-25 (Pre-59½ Distributions) 
Q-11: Does the 10-percent tax under section 72(t) apply to amounts that are included in a 
plan participant’s gross income pursuant to section 72(m)(3)? 
A-11: No. Section 72(m)(3) provides generally that employer contributions and trust 
income that are treated under regulations as having been applied to the purchase of life 
insurance protection for a plan participant must be included in the participant’s gross 
income. However, such an amount is not treated as a distribution for purposes of section 
72(t). 
 
Q-12: In the case of an IRA or individual account plan, what constitutes a series of 
substantially equal periodic payments for purposes of section 72(t)(2)(A)(iv)? 
A-12: Section 72(t)(1) imposes an additional tax of 10 percent on the portion of early 
distributions from qualified retirement plans (including IRAs) includable in gross 
income. However, section 72(t)(2)(A)(iv) provides that this tax shall not apply to 
distributions which are part of a series of substantially equal periodic payments (not less 
frequently than annually) made for the life (or life expectancy) of the employee or the 
joint lives (or joint life expectancies) of the employee and beneficiary. Section 72(t)(4) 
provides that, if the series of periodic payments is subsequently modified within five 
years of the date of the first payment, or, if later, age 59 1/2, the exception to the 10 
percent tax under section 72(t)(2)(A)(iv) does not apply, and the taxpayer’s tax for the 
year of modification shall be increased by an amount, determined under regulations, 
which (but for the 72(t)(2)(A)(iv) exception) would have been imposed, plus interest. 
Payments will be considered to be substantially equal periodic payments within the 
meaning of section 72(t)(2)(A)(iv) if they are made according to one of the methods set 
forth below. 
 
Payments shall be treated as satisfying section 72(t)(2)(A)(iv) if the annual payment is 
determined using a method that would be acceptable for purposes of calculating the 
minimum distribution required under section 401(a)(9). For this purpose, the payment 
may be determined based on the life expectancy of the employee or the joint life and last 
survivor expectancy of the employee and beneficiary. 
 
Payments will also be treated as substantially equal periodic payments within the 
meaning of section 72(t)(2)(A)(iv) if the amount to be distributed annually is determined 
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by amortizing the taxpayer’s account balance over a number of years equal to the life 
expectancy of the account owner or the joint life and last survivor expectancy of the 
account owner and beneficiary (with life expectancies determined in accordance with 
proposed section 1.401(a)(9)-1 of the regulations) at an interest rate that does not exceed 
a reasonable interest rate on the date payments commence. For example, a 50 year old 
individual with a life expectancy of 33.1, having an account balance of $100,000, and 
assuming an interest rate of 8 percent, could satisfy section 72(t)(2)(A)(iv) by distributing 
$8,679 annually, derived by amortizing $100,000 over 33.1 years at 8 percent interest. 
Finally, payments will be treated as substantially equal periodic payments if the amount 
to be distributed annually is determined by dividing the taxpayer’s account balance by an 
annuity factor (the present value of an annuity of $1 per year beginning at the taxpayer’s 
age attained in the first distribution year and continuing for the life of the taxpayer) with 
such annuity factor derived using a reasonable mortality table and using a interest rate 
that does not exceed a reasonable interest rate on the date payments commence. If 
substantially equal monthly payments are being determined the taxpayer’s account 
balance would be divided by an annuity factor equal to the present value of an annuity of 
$1 per month beginning at the taxpayer’s age attained in the first distribution year and 
continuing for the life of the taxpayer. For example, if the annuity factor for a $1 per year 
annuity for an individual who is 50 years old is 11.109 (assuming an interest rate of 8 
percent and using the UP-1984 Mortality Table), an individual with a $100,000 account 
balance would receive an annual distribution of $9,002 ($100,000/11.109 = $9,002). 

Minimum Distributions Incidental Benefit 
Non-spousal distributions will be subjected to the Minimum Distribution Incidental 
Benefit (MDIB) requirement (see IRC Proposed Treas. Reg. §1.401(A)(9)-2). The MDIB 
requirement states that any distribution occurring after the Required Beginning Date must 
be less than the distribution that was calculated by dividing the balance of the plan by the 
MDIB Table divisor found in IRC Proposed Treas. Reg. §1.401 (a)(9)-2, Q-4. Generally, 
when the non-spousal beneficiary is more than ten years younger than the plan owner, the 
MDIB is triggered and results in a joint life expectancy factor, regardless of the actual 
age of the non-spousal beneficiary. Thus, during the lifetime of the plan owner but after 
the plan owner reaches age 70½, there is no difference in the minimum distribution 
payout amount, regardless of whether the non-spousal beneficiary is 15 or 30 years 
younger than the plan owner is. 
 
The program always removes the MDIB limitation after the plan owner’s death. 
Authority for Removal of MDIB after the death of the plan owner is found in IRS 
Publication 590 and IRC Proposed Treas. Reg. §1.401(a)(9)-2, Q&A Q-3. If the owner 
made an appropriate election before the required beginning date, a joint term certain 
method will be used after the plan owner’s death (rather than just a single life term 
certain for the beneficiary in cases where the owner was using a recalculation method). 
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MDIB Table for Determining Applicable Divisor 
Age Divisor Age Divisor 
70 26.2 93 8.8 
71 25.3 94 8.3 
72 24.4 95 7.8 
73 23.5 96 7.3 
74 22.7 97 6.9 
75 21.8 98 6.5 
76 20.9 99 6.1 
77 20.1 100 5.7 
78 19.2 101 5.3 
79 18.4 102 5.0 
80 17.6 103 4.7 
81 16.8 104 4.4 
82 16.0 105 4.1 
83 15.3 106 3.8 
84 14.5 107 3.6 
85 13.8 108 3.3 
86 13.1 109 3.1 
87 12.4 110 2.8 
88 11.8 111 2.6 
89 11.1 112 2.4 
90 10.5 113 2.2 
91 9.9 114 2.0 
92 9.4 115 + 1.8 

Minimum Distributions Options 
Required Minimum Distributions: 

Calculations under the Final Regulations 
After more than a decade of proposed regulations, final minimum distribution regulations 
were published on April 17, 2002. These new rules are based primarily on the proposed 
regulations of 2001, but they do add some new calculation wrinkles to consider. 
As with the 2001 proposed regulations, the final regulations keep the basic calculation 
intact. Each year, the distribution is calculated by dividing the previous year’s ending 
balance by a life expectancy number. The calculation complexity lies in determining the 
life expectancy number.  
 
Here’s how the new rules work: 
 
Situation I: Owner still alive 
If the owner is still alive, the life expectancy is taken straight from the Uniform Lifetime 
Table. Simply find the owner’s age on the table (it covers ages 70 through 115), and use 
the life expectancy listed. For this situation, the only change caused by the 2002 final 
regulations was to update the numbers in the Uniform Lifetime Table. 
Prior to 2001, the Uniform Lifetime Table was known as the MDIB table, and was used 
only for nonspousal beneficiaries. Now, it is used whenever the owner is alive, making 
the distribution calculation very straightforward. There is only one exception to this rule: 
cases involving spousal beneficiaries who are more than ten years younger than the 
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owner. In that case, the joint life expectancy of the owner and spouse is used. Once the 
owner dies, this exception no longer applies, and Situation 4 (see below) applies. 
 
Situation 2: Owner dies with no beneficiary 
In the year of death, the minimum distribution is still calculated according to Situation 1 
(above). It’s only in the years after the owner’s death that this situation applies. 
If the owner dies before the required beginning date, and there is no beneficiary alive as 
of the owner’s death, the five year rule applies—all the money has to be distributed 
within five years of the year the owner died. 
 
If the owner dies on or after the required beginning date, and there is no beneficiary alive 
as of the date of death, distributions after the owner’s death are taken over a term based 
on the owner’s life expectancy in the year of death. This calculation is easier than it 
sounds. For the year after death, subtract one from the owner’s single life expectancy in 
the year of death. As each year passes, reduce the life expectancy by one. For example, if 
the owner died in 2003, the distribution in 2004 would be based on the owner’s 2003 life 
expectancy minus one. 
 
The new life expectancy tables used by the 2002 final regulations add some complexity 
to cases where the owner has already died. If distributions are being taken under this 
scenario, the length of the term has to be recalculated using the 2002 single life 
expectancy table. For example, if a plan owner died in 1995, the 2003 distribution would 
be based on the owner’s life expectancy (using the new table) in 1995 reduced by 8. 
Under the 2001 proposed regulations, the beneficiary had to be alive as of 12/31 of the 
year following the owner’s death to be considered valid. Under the 2002 regulations, the 
beneficiary only has to be alive when the owner dies to be considered.  
 
Situation 3: Owner dies with nonspousal beneficiary 
In the year of death, the minimum distribution is still calculated according to Situation 1 
(above). It’s only in the years after the owner’s death that this situation applies. 
When the owner dies with a nonspousal beneficiary, a term certain distribution period is 
established based on the designated beneficiary’s single life expectancy in the year after 
the owner’s death. Unlike Situation 2, in this case the term is based on a life expectancy 
calculated in the year after the owner’s death, rather than the year of death. For example, 
if the owner died in 2003, the life expectancy used as the divisor in 2004 would be the 
beneficiary’s single life expectancy in 2004. In 2005, the divisor used would be 2004’s 
number minus 1. The life expectancy in the year after death is, of course, calculated using 
the new single life expectancy table, and, as with Situation 2, an existing term certain 
would have to be recalculated using the new table. 
 
The 2002 final regulations add another wrinkle to those situations when the owner died 
on or after the required beginning date. In these situations, the life expectancy used is the 
greater of the one calculated using the “no beneficiary” case (situation 2), and the one 
resulting from the calculation described in the previous paragraph. This can get a little 
confusing, because the “no beneficiary” case starts with a term calculated in the year of 
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death, while the nonspousal beneficiary’s term certain starts the year after the owner’s 
death. 
 
Situation 4: Owner dies with spousal beneficiary 
In the year of death, the minimum distribution is still calculated according to Situation 1 
(above). It’s only in the years after the owner’s death that this situation applies. 
When the owner dies with a spousal beneficiary, the spouse gets special treatment. In this 
case, the distributions are based on the spouse’s single life expectancy recalculated each 
year after the owner’s death. If the owner dies prior to the calendar year in which he 
would have reached age 70½, the spouse does not have to start taking distributions until 
that year. Upon the spouse’s death, the distributions become term certain, with the term 
set to the spouse’s life expectancy in the year of death. This works the same as the old 
term certain method, with the life expectancy being reduced by one for each year that 
passes after the spouse’s death. 
 
As with situation 3, the 2002 final regulations add more complexity. For cases where the 
client dies on or after the required beginning date, the life expectancy used is the greater 
of the one calculated using the “no beneficiary” case (situation 2), and the one resulting 
from the calculation described in the previous paragraph. 
 
When do these apply? 
In 2002, there is the option of using either the pre-2001 proposed regulations (with all 
their calculation and recalculation options), the 2001 proposed regulations, and the 2002 
final regulations. After 2002, only the 2002 final regulations may be used.  
The 2002 final regulations added more than just a new mortality table to these 
calculations. They also added complexity. When all the different situations listed above 
are taken together, they represent a fairly complicated set of calculations that have to be 
correctly performed to make sure you calculate the correct distribution for your clients.  
 2002, Brentmark Software, Inc. All Rights Reserved. 

Calculating Required Minimum Distributions using the 2001 Proposed 
Regulations: 
The regulations released on 1/11/2001 radically changed the way minimum distributions 
have to be calculated. They eliminated a lot of complexity reduced the number of 
decisions made by a plan owner. These regulations eliminated the old recalculation 
options. There is no "hybrid method" or "joint term certain method." However, the new 
methodology does still have some similarities to the old. For example, the distribution is 
still calculated by dividing the previous year's balance by a life expectancy number. 
Here’s how it works: 

Situation 1: Owner still alive 
If the owner is still alive, the distributions are based on the divisor found in the MDIB 
table for owner’s age. The MDIB table is a published table of joint life expectancies for 
an owner and a beneficiary who is ten years younger than the owner. It simplifies the 
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calculation to only using the owner’s age. No beneficiary information is needed, and no 
recalculation options are available. There is only one exception to this rule – for cases 
involving spousal beneficiaries that are more than ten years younger than the owner. 
 

Situation 2: Owner dies with nonspousal beneficiary 
When the owner dies with a nonspousal beneficiary, a term certain distribution period is 
established, based on the designated beneficiary's single life expectancy in the year after 
the owner’s death. As with the old term certain method, this life expectancy is simply 
reduced by one for each year after it is calculated. 
 

Situation 3: Owner dies with no beneficiary 
This is the only situation where the owner’s required beginning date is relevant. If the 
owner dies before the required beginning date, and there is no beneficiary alive as of 
12/31 of the year following the owner's death, the five year rule applies – all the money 
has to be distributed within the next five years. 
 
If the owner dies after the required beginning date, and there is no beneficiary alive as of 
12/31 of the year following the owner’s death, the distributions are taken out over a term 
based on the owner’s life expectancy in the year of death. Once again, this works the 
same as the old term certain method, with the life expectancy being reduced by one for 
each year that passes after the owner’s death. 
 

Situation 4: Owner dies with spousal beneficiary 
When the owner dies with a spousal beneficiary, the spouse gets special treatment. In this 
case, required distributions are generally based on the spouse’s single life expectancy in 
each year after the owner’s death.  
 
If the owner dies prior to the calendar year in which he would have reached age 70½, the 
spouse does not have to start taking distributions until that year. However, if the owner 
dies before 12/31 of the calendar year in which he would have reached age 70½ and the 
spouse also dies before 12/31 of the calendar year in which the original owner would 
have reached age 70½, then the second-to-die spouse is treated as the new owner with the 
rules of Situation 2 being applied if the second-to-die spouse has a designated beneficiary 
or Situation 3 if there is no designated beneficiary.  
 
If the spouse dies after the year in which the original owner would have turned 70½, the 
distributions become term certain, with the term set to the spouse’s life expectancy in the 
year of death. Again, this works the same as the old term certain method, with the life 
expectancy being reduced by one for each year that passes after the spouse’s death. 
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Situation 5: Owner dies and a spousal rollover 
When the owner dies with a spousal beneficiary, the spouse has the option of doing a 
spousal rollover with the spouse becoming the new owner.  In such a case, the rules of 
Situation 1 apply after the spouse becomes the new owner.   
Situation 6: The Exception to Situation 1 
The exception to situation 1 is when there is a spousal beneficiary who is more than 10 
years younger than the owner. In this case, the life expectancy used while the owner is 
alive is the joint life expectancy of the owner and spouse, recalculated in each year. Once 
the owner dies, the exception no longer applies, and the distribution is handled according 
to the situations described above. 

1987 Proposed Regulations (Pre-2001 Rules) 

If the plan owner has not named a beneficiary 
If the plan owner has not named a beneficiary, then there are two methods for 
determining the plan owner’s life expectancy each year: Term Certain method or 
Recalculation method. Use the Recalculate Owner’s Life Exp. check box to determine the 
method: 
• Term Certain method—Clear the Recalculate Owner’s Life Exp. check box. The 

program uses Table V to determine the owner’s life expectancy in for the 
Required Beginning Date (first year that distributions are required). Thereafter, 
the program subtracts one from the life expectancy each year. 

• Recalculation method—Click the Recalculate Owner’s Life Exp. check box. The 
program uses Table V to determine the life expectancy each year. 

 

If the plan owner has named a beneficiary 
Plan owners and beneficiaries have the ability to recalculate their life expectancies 
annually (see Note). If the plan owner has named a beneficiary, then there are actually 
four methods of recalculating life expectancies each year. Use the Recalculate Owner’s 
Life Exp. and the Recalculate Beneficiary’s Life Exp. check boxes to determine the 
method: 
 
Joint Recalculation method—Click both check boxes. Both life expectancies are 
recalculated. The program uses Table VI to determine the minimum distribution from the 
life expectancies.  
Joint Term Certain method—Clear both check boxes. Neither life expectancy is 
recalculated. Both the owner and the beneficiary use the term certain method. Both life 
expectancies decrease by 1 annually.  
Hybrid method—Only click Recalculate Owner’s Life Exp. The owner's life expectancy 
is recalculated and the beneficiary uses the term certain method. Using the beneficiary's 
deemed age ((determined using single life Table V) and the owner's actual age, the 
program uses joint life Table VI to determine the minimum distribution. Many planners 
recommend this method when the plan owner is older than the beneficiary. 
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Hybrid method—Only click Recalculate Beneficiary’s Life Exp. The beneficiary's life 
expectancy is recalculated, and the owner uses the term certain method. Using the 
owner's deemed age (determined using single life Table V) and the beneficiary's actual 
age, the program uses joint life Table VI to determine the minimum distribution. Planners 
recommend this variant when the beneficiary is older than the plan owner. 
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Table V from Reg. Sec. 1.72- 9 

Mortality Table 
The program offers the 90CM Table, the §1.72 (1983 table listed in IRS Regulations 
§1.72-7(c)(1)(iii)), the UP-1984 Table (the UP-84 Table is only used in single life 
expectancy cases), and the 80CNSMT (1980 table from IRS publication 1457).  The 
example in IRS Notice 89-25, 1989-1 C.B. 662 uses the UP-1984 Mortality Table. As of 
May 1, 1999, the IRS released the 90CM mortality table. This table replaces the older 
80CNSMT. Between May 1, 1999, and June 30, 1999, you can use either the 80CNSMT 
or the 90CM. After June 30, 1999, do not use the 80CNSMT (REG-103851-99). 

Age Multiple Age Multiple Age Multiple 
5 76.6 43 39.6 81 8.9 
6 75.6 44 38.7 82 8.4 
7 74.7 45 37.7 83 7.9 
8 73.7 46 36.8 84 7.4 
9 72.7 47 35.9 85 6.9 

10 71.7 48 34.9 86 6.5 
11 70.7 49 34.0 87 6.1 
12 69.7 50 33.1 88 5.7 
13 68.8 51 32.2 89 5.3 
14 67.8 52 31.3 90 5.0 
15 66.8 53 30.4 91 4.7 
16 65.8 54 29.5 92 4.4 
17 64.8 55 28.6 93 4.1 
18 63.9 56 27.7 94 3.9 
19 62.9 57 26.8 95 3.7 
20 61.9 58 25.9 96 3.4 
21 60.9 59 25.0 97 3.2 
22 59.9 60 24.2 98 3.0 
23 59.0 61 23.3 99 2.8 
24 58.0 62 22.5 100 2.7 
25 57.0 63 21.6 101 2.5 
26 56.0 64 20.8 102 2.3 
27 55.1 65 20.0 103 2.1 
28 54.1 66 19.2 104 1.9 
29 53.1 67 18.4 105 1.8 
30 52.2 68 17.6 106 1.6 
31 51.2 69 16.8 107 1.4 
32 50.2 70 16.0 108 1.3 
33 49.3 71 15.3 109 1.1 
34 48.3 72 14.6 110 1.0 
35 47.3 73 13.9 111 .9 
36 46.4 74 13.2 112 .8 
37 45.4 75 12.5 113 .7 
38 44.4 76 11.9 114 .6 
39 43.5 77 11.2 115 .5 
40 42.5 78 10.6   
41 41.5 79 10.0   
42 40.6 80 9.5   
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Note 
Brentmark has permission to use the UP-1984 Table Copyright(c) 1976 Conference of Consulting Actuaries, 
All Rights Reserved. 

Net After-Tax Assets 
The Net After-Tax Assets is the sum of the Pension, Roth IRA, and Other Assets funds 
(plus Insurance Proceeds, if any) less income and estate taxes.  
Since income and estate taxes are generally payable only after the death of the surviving 
spouse, the Net After-Tax Assets value assumes the death of the owner and the spouse 
each year with estate taxes being paid from the Other Assets, not the Pension Fund (if 
possible). In most cases, the surviving heir does not have to withdraw the entire balance 
from the Pension Fund or Roth IRA at the time of death. Instead, he or she can let the 
money grow tax-free or tax-deferred and withdraw the money according to minimum 
distribution rules. Often, this growth is over a long period of time because it is based on 
the heir’s term certain life expectancy. 
 
To reflect the effects of such deferral on the Net After-Tax Assets, select Estate Analysis: 
Max Deferral in the Main Inputs section. When select Estate Analysis: Max. Deferral, the 
program calculates the Net After-Tax Assets using the following formula: 
Net After-Tax Assets =P.V. of Future After-Tax Distributions 
+ Distributions to Other Assets 
-  Federal Estate Tax 
-  State Death Tax 
If you clear Estate Analysis: Max Deferral, the program does not include the Present 
Value of Future After-Tax Distributions because there is no deferral term. 
To see how the program calculates the Net After-Tax Assets, view the Estate Analysis 
Report. 

Present Value of Future After-Tax Distributions 
This is the present value of all future distributions (after income tax) that the heir will 
take from the Pension Fund and/or the Roth IRA over the heir’s term certain life 
expectancy, or deferral term. The program uses the after-death Discount Rate to calculate 
the present value of future after-tax distributions. Then the program uses the present 
value of future after-tax distributions to calculate the Net-After Tax Assets.  
In most cases, the surviving heir does not have to withdraw the entire balance from the 
Pension Fund or Roth IRA after the death of the plan owner or the second to die. Instead, 
he or she can let the money grow tax-deferred or tax-free and withdraw the money 
according to minimum distribution rules. Often, this growth is over a long period of time 
because it is based on the heir’s term certain life expectancy. When you click Estate 
Analysis: Max. Deferral in the Main Inputs section, the program assumes that the heir 
takes advantage of the deferral. 
 
 



Chapter 21:  Reference Material 

 102 

To see how the program uses the Present Value of Future After-Tax Distributions to 
calculate the Net After-Tax Assets, view the Estate Analysis Report. 

Reasonable Interest Rate 
A so-called “reasonable” interest rate is required when using the Amortization or 
Annuitization methods to compute a pre-59½ pension plan distribution that avoids the 
10% penalty for early distributions (see IRS Notice 89-25, 1989-1 C.B. 662, Q&A 11 and 
12). In various letter rulings, the IRS has accepted use of the 120% Annual Long-Term 
Applicable Federal Rate for the month in which distributions start. Some commentators 
read some of the rulings as saying that you should use 120% of the Annual Long-Term 
Rate, which is slightly different. However, the difference may be seen as de minimus. If 
you judge this rate to be appropriate, it may be used in the Pension Distributions 
Calculator. 

 

Note 
Letter Rulings cannot be used as binding authority for IRS positions. Since the IRS has not issued any 
rulings other than Letter Rulings on the topic of "reasonable" interest rates for pre-59½ distributions, there is 
no binding authority on this topic. 
 

The IRS has accepted use of the Annual Long-Term 120% Applicable Federal Rate.  
These rates are posted on Brentmark’s web site, http://www.brentmark.com.  
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Chapter 22 
Report Listing 

Distributions Breakdown Report 
The Distributions Breakdown report helps you see how much of each distribution is 
going to income taxes, insurance premiums, gift fund contributions, income, and, finally, 
how much is left for the Other Assets. 

Report Values 

• Year 

• Annual Distributions 

• Distribution From Other Assets 

• Income Tax on Pension 
Distributions 

• Income Tax on Other Assets 
Distributions 

• Income Tax on Roth IRA 
Distribution 

• Penalty on Pension Distributions 

• Penalty on Roth IRA Distribution 

• FET Deduction Used by 
Distributions 

• Total Conversion Tax Paid 

• Distributions to Gift Fund 

• Distributions to Insurance 

• Distributions to Income 

• Distributions to Other Assets 

Donee Exclusion Gifting Analysis Report 
The Donee Exclusion Gifting Analysis report shows how much money each fund pays 
toward donee exclusion gifts. The report also lists the annual value of the gift fund. 

Report Values 

• Year 

• Gift Fund Begin Value 

• Gift Fund Contribution 

• Pension Fund Distributions to Gift 
Fund 

• Roth IRA Distributions to Gift 
Fund 

• Taxes at Death Paid from Gift 
Fund 

• Gift Fund Ending Value 
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Estate Analysis Report 
The Estate Analysis report illustrates the calculation of the Net After-Tax Assets. The 
report assumes that the owner and spouse (if there is one) die by the end of each year. 
The report also shows the effects of estate taxes and income taxes on the Other Assets. If 
you have not clicked Estate Analysis: Max. Deferral in the Main Inputs section, the report 
will not include a P.V. of Future After-Tax Distributions column. In such a case, the heir 
withdraws the entire balance of the plan after the death of both the plan owner and the 
beneficiary.  

 Report Values 

• Year 

• Roth IRA Ending Value 

• Pension Fund Ending Value 

• Other Assets Ending Value 

• Gift Fund Ending Value 

• Unpaid Roth IRA Taxes 

• Federal Estate Tax 

• State Death Tax 

• Income Tax on Pension Fund 

• Pension Deferral Term 

• Roth Deferral Term 

• P.V. of Future After-Tax 
Distributions 

• Insurance Proceeds 

• Net After-Tax Assets 

Insurance Analysis Report 
The Insurance Analysis report displays the amount of money distributed for payment of 
premiums and shows the benefit of the proceeds to the Net After-Tax Assets.  

Report Values 

• Year 

• Insurance Premium 

• Distributions to Insurance 

• Insurance Proceeds 

• Taxes at Death Paid from 
Insurance 

• Pre-Insurance Net Assets 

• Net After-Tax Assets 

Life Expectancies Analysis Report 
The Life Expectancies report simply lists all the life expectancies that are calculated for 
each year. 
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Report Values 

• Year 

• Owner L/E 

• Spouse L/E 

• Joint L/E 

• 2nd Benef L/E 

• 2nd Joint L/E 

• Life Exp 

• Roth IRA Benef. Life Exp 

• Pension Deferral Term 

• Roth Deferral Term 

Minimum Distributions Life Expectancy Analysis Report 
This report shows the different minimum distribution multiples that could be used in each 
year. It helps illustrate what would happen to the distributions if death were to occur. 

Report Values 

• Year 

• Owner Age 

• Benef Age 

• Benef Deemed Age 

• Multiple if Both Alive 

• Multiple if Only Client Alive 

• Multiple if Only Spouse Alive 

• Multiple if Neither Alive 

Minimum Distributions Report 
The Minimum Distributions Report lists the following information: 
 
Year  
This column lists each year that the program calculates a distribution. By default, the 
program displays years of death for the owner and beneficiary in red. You can change 
the color using the  
 
Age  
This column lists the owner’s age in each year. 
 
Plan Balance 
This column lists the total amount of money in the owner’s pension plan in each year. 
To calculate the Plan Balance for each year, the program uses the following formula: 
 
(Current Plan Balance) * (1 + Expected Plan Growth) – (Calculated Distribution) + 
(Contributions) 
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Life Expectancy Factor 
This column lists the life expectancy factors that are used to calculate the minimum 
distribution. To calculate the life expectancy factors, the program uses the ages of the 
Owner and/or the Beneficiary and applies them to the minimum distribution rules. 
 
Minimum Distribution Amount 
This column lists the minimum distribution in each year. To calculate the minimum 
distribution amount, the program amortizes the Plan Balance over the Life Expectancy 
factor. 

Other Assets Analysis Report 
This report shows all the activity (contributions, distributions, growth, etc.) that affects 
the Other Assets each year.  

Report Values 

• Year 

• Other Assets Begin Value 

• Distributions to Other Assets 

• Net Amount From Taxable 
Annuity 

• Other Assets Contribution 

• Other Assets Ending Value 

• Adjustment to Other Assets 

• Distribution From Other Assets 

• Income Tax on Other Assets 
Distributions 

• Tax Saved by Pension 
Contribution 

• Other Assets Net Growth 

 

Other Assets Growth Analysis Report 
The Other Assets Growth Analysis report illustrates how the Other Assets growth is 
taxed in each year. When you enter a Percent of Growth Realized that is less than 100%, 
the calculation of the tax on that growth depends on how much is realized in each year. 
This report shows you how that calculation works. 

Report Values 

• Year 

• Other Assets Begin Value 

• Pre-Tax Fund Growth 

• Realized Growth 

• Tax on Fund Growth 

• Unrealized Growth 

• Other Assets Net Growth 
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Pension Fund Analysis Report  
This report shows all the activity (contributions, distributions, growth, etc.) that affects 
the Pension Fund in each year. 

Report Values 

• Year 

• Pension Fund Begin Value 

• Pension Contribution 

• Pension Fund Distributions 

• Roth IRA Conversion 

• Conversion Tax Paid From 
Pension Fund 

• Pension Fund Growth 

• Pension Fund Ending Value 

• Taxes at Death Paid from Pension 
Fund 
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Pre-59½ Distributions Analysis Report 
When you use the Pre-59½ Distributions, the results of these calculations appear in every 
report; however, the report that appears in the Main window displays results with growth 
that has been compounded annually. Therefore, results that appear in the Pre-59½ 
Distributions window may have different balances.  
Pre-59½ distributions have to last for 5 years and must be paid until the plan owner 
reaches age 59½.  Usually, this results in distributions being made for a portion of the 
year that the owner reaches age 59½.  For example, if distributions are being taken 
quarterly, and the plan owner turns age 59½ in February 2010, only the first distribution 
has to be in 2010.  If distributions occur at the end of each quarter, no distributions would 
have to be made in 2010 (assuming that five years worth of distributions have already 
been taken).   

Report Values 

• Year 

• Pension Fund 

• Owner’s Age 

• Life Exp. 

• Distributions 

Roth IRA Analysis Report  
This report shows all the activity (contributions, distributions, growth, etc.) that affects 
the Roth IRA in each year. 

Report Values 

• Year 

• Roth IRA Begin Value 

• Roth IRA Conversion 

• Roth IRA Contribution 

• Roth IRA Distributions 

• Conversion Tax Paid From Roth IRA 

• Roth IRA Growth 

• Roth IRA Ending Value 

• Taxes at Death Paid from Roth IRA 

Roth IRA Distributions Report 
Once the owner of a Roth IRA dies, there is a minimum distribution to the surviving 
beneficiary. The Roth IRA Distributions report shows you the distribution and the life 
expectancy that the program uses to calculate the distribution. 
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Report Values 

• Year 

• Benef. Age 

• Roth IRA Begin Value 

• Roth IRA Benef. Life Exp 

• Roth IRA Distributions 

• Cumulative Roth IRA 
Distributions 

Roth IRA Taxes & Penalties Report 
The Roth IRA Taxes and Penalties report shows the taxes generated both by the Roth 
IRA conversion and by any distributions taken from the Roth IRA within five years of 
that conversion. 

Report Values 

• Year 

• Roth IRA Distributions 

• Roth IRA Conversion 

• Conversion Tax Paid From Other 
Assets 

• Conversion Tax Paid From Roth 
IRA 

• Conversion Tax Paid From 
Pension Fund 

• Income Tax on Roth IRA 
Distribution 

• Penalty on Roth IRA Distribution 
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Summary Report 
The Summary report provides you with an overview of the analysis. It shows how money 
is moving between funds and how this movement affects the Net After-Tax Assets. This 
report does not read left to right; adding from left to right will not produce the Net After-
Tax Assets. This report simply displays columns of numbers that are important to 
summarizing an analysis.  

Report Values 

• Year 

• Pension Fund Begin Value 

• Roth IRA begin Value 

• Annual Distributions 

• Other Assets Ending Value 

• Net After-Tax Assets 

Taxable Amount of Pension Fund Report  
This report shows how the Federal Estate Tax Deduction is calculated in each year.  

Report Values 

• Year 

• Taxable Estate 

• Estate Tax (charged on the entire 
taxable estate) 

• Taxable Estate (without Pension 
Fund) 

• Estate Tax (without Pension 
Fund)  

• Federal Estate Tax Deduction 
(which equals the amount of estate 
tax attributed to the Pension Fund) 

• Pension Fund (subject to income 
tax) 
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Taxable Estate Analysis Report 
This analysis shows how the Taxable Estate is calculated each year. 

Report Values 

• Year 

• Roth IRA Ending Value 

• Pension Fund Ending Value 

• Other Assets Ending Value 

• Total Funds Ending Value 

• Equivalent Exemption 

• Unpaid Roth IRA Taxes 

• Taxable Estate 

Total Funds Ending Value Report 
This analysis shows the total (pre-tax) funds at the end of each year. 

Report Values 

• Year 

• Roth IRA Ending Value 

• Pension Fund Ending Value 

• Other Assets Ending Value 

• Total Funds Ending Value 

• Gift Fund Ending Value 
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Total Pension & IRA Distributions Report 
The Total Distributions report illustrates the total value of all distributions from the 
Pension Fund and the Roth IRA. This report includes the income tax charged on the 
Pension Fund Distribution. The report effectively illustrates the calculation of the 
Cumulative Combined Distribution number. 

Report Values 

• Year 

• Pension Fund Distributions 

• Income Tax on Pension 
Distributions 

• Roth IRA Distributions 

• Yearly After-Tax Distributions 

• Cumulative After-Tax 
Distributions 

Cumulative After-Tax Distributions Report 
This report compares the total amount of money distributed from the Pension Fund and 
Roth IRA through each year. 

Cumulative Net Proceeds Report 
This report compares the net cumulative amount of money spent from all the funds to pay 
living expenses, make gift fund contributions, and pay insurance premiums. This value is 
only useful if you have indicted that some of these costs apply  

Net After-Tax Assets Report 
This report compares the value of the assets to the family, assuming the 2nd -to-die of the 
plan owner and spouse has died by the end of each year. If Estate Analysis: Max Deferral 
is selected, the Net After-Tax Assets includes the present value of the future after-tax 
distributions that the heir can take. 

Other Assets Ending Value Report 
This report compares the balances of the Other Assets at the end of each year. 

Pension Fund Distributions Report 
This report compares the distributions from the Pension Fund in each year. 
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Pension Fund Ending Value Report 
This report compares the balances of the Pension Fund at the end of each year. 

Roth IRA Ending Value Report 
This report compares the balances of the Roth IRA at the end of each year. 

Yearly After-Tax Distributions Report 
This report compares the net distribution from the Pension Fund and Roth IRA in each 
year. 
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Chapter 23  
Descriptions of the Available Values 

 
Following is a complete list of every value that appears in the program’s reports. These 
values appear in the Available Values box in the Report Designer. You can use the 
Report Designer to create custom reports. For more information about the Report 
Designer, see Chapter 17, Designing a Report. 
 
Value Description 
2nd Benef L/E The spousal beneficiary’s life expectancy in each year. 

 
2nd Joint L/E The joint life expectancy of the secondary beneficiary 

and either the owner or the owner’s spouse each year. 

Adjustment to Other Assets The amount of adjustment to Other Assets in each 
year. 

After-Tax Pension Fund 
Distributions 

The net distribution from the Pension Fund in each 
year. 

 
AGI The annual adjusted gross income used to calculate 

annual income taxes. 

 
Amount Needed For Gift Fund The total amount of money needed annually for 

Donee-Exclusion Gifting. 

 
Amount Needed For Income The total amount of money needed annually for living 

expenses. 

 
Amount Needed For Ins. Premium The total amount of money needed annually to pay life 

insurance premiums. 

 
Annual Distributions The annual distribution from the Pension Fund and 

Roth IRA. 

 
Benef. Age The IRA beneficiary’s age in each year. 
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Conversion Tax Paid From Other 
Assets 

The annual amount of Roth IRA conversion taxes paid 
from the Other Assets. 

 
Conversion Tax Paid From Pension 
Fund 

The annual amount of Roth IRA conversion taxes paid 
from the Pension Fund.  

 
Conversion Tax Paid From Roth 
IRA 

The annual amount of Roth IRA conversion taxes paid 
from the Roth IRA.  

Converted Balance of Roth IRA The taxable conversion portion of the Roth IRA 
beginning balance in each year. 

 
Cumulative After-Tax Distributions The total amount of money distributed from the 

Pension Fund and Roth IRA through annually. 

 
Cumulative Net Proceeds  The net cumulative amount of money spent (from all 

the funds) to pay living expenses, make gift fund 
contributions, and pay insurance premiums.  This 
value is only useful if you have indicated that some of 
these costs apply. 

 
Cumulative Pension Distributions The total amount of money distributed from the 

Pension Fund annually. 

 
Cumulative Roth IRA Distributions The total amount of money distributed from the Roth 

IRA annually. 

 
Distribution From Other Assets The annual distribution taken from the Other Assets. 
Distributions to Gift Fund The total amount distributed for Donee-Exclusion 

Gifting in each year. 

 
Distributions to Income The total annual distribution for Living Expenses.  

 
Distributions to Insurance The total annual distribution for amount for insurance 

premiums.  
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Distributions to Other Assets The amount taken from the Pension Fund and the Roth 
IRA for the Other Assets in each year. 

 
Earnings Balance of Roth IRA The earnings portion of the Roth IRA beginning 

balance in each year. 

 
Entered AGI The annual base adjusted gross income that is used to 

calculate income taxes. 

 
Equivalent Exemption The equivalent exemption for federal estate taxes in 

each year. 

 
Estate Tax (Whole Estate) The annual federal estate tax on the total taxable estate.
  
Estate Tax (Without Pension) The annual federal estate tax on the taxable estate if 

there were no Pension Fund. 

 
Federal Estate Tax Deduction The annual federal estate tax attributable to the 

Pension Fund. 
Federal Estate Tax The federal estate tax due if plan owner dies at end of 

each year. 

 
FET Deduction Used by 
Distributions 

The annual amount of federal estate tax deduction used 
by the Pension Fund distribution.  

 
Gift Fund Begin Value The balance of the Gift Fund at the beginning of each 

year. 

 
Gift Fund Contribution The amount of money contributed to the gift fund in 

each year. 

 
Gift Fund Ending Value The balance of the Gift Fund at the end of each year. 

 
Growth Rate of Other Assets The annual percent increase of Other Assets. 
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Growth Rate of Pension Fund The annual percent increase of a Pension Fund.  

 
Growth Rate of Roth IRA The annual percent increase of a Roth IRA. 

 
Heir’s AGI The heir’s annual adjusted gross income used to 

calculate income taxes.  

 
Income Tax on All Distributions The total income tax generated by all distributions 

annually. 

 
Income Tax on Conversion The income tax due on the Roth IRA Conversion 

annually. 

 
Income Tax on Other Assets 
Distributions 

The annual income tax generated by distributing 
unrealized growth from the Other Assets throughout 
each year. 

 
Income Tax on Pension 
Distributions 

The annual income tax on Pension Fund distributions.  

Income Tax on Pension Fund The annual income tax on the Pension Fund if owner 
dies at end of each year. 

 
Income Tax on Roth IRA 
Distribution 

The amount of income taxes generated by the Roth 
IRA distribution in each year. 

 
Insurance Premium The annual amount of the insurance premiums.  

 
Insurance Proceeds The total amount of 2nd-to-die life insurance proceeds 

which would be payable annually. 
Joint L/E The annual joint life expectancy of the owner and 

beneficiary. This value is set to 0 after a spousal 
rollover to indicate that it is no longer used. 

 
Life Exp The life expectancy used to calculate minimum 

distributions each year. 
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Minimum Distributions The minimum required Pension Fund distribution in 
each year. 

 
Money Lost to Taxes The total amount of taxes paid annually. 

 
Net After-Tax Assets The value of the assets to the family, assuming the 

2nd-to-die of the owner and spouse has died by the end 
of each year.  If maximum deferral is indicated, it 
includes the present value of the future distributions 
the heirs can take. 

 
Net Amount From Taxable Annuity The annual net value of the Taxable Annuity.  This 

amount is reinvested in the Other Assets. 

 
Net Cumulative Pension 
Distributions 

The total net amount of money distributed from the 
Pension Fund through each year. 

 
Net Proceeds The net amount of money taken from all the funds in 

each year. 

 
Other Assets Begin Value The balance of the Other Assets at the beginning of 

each year. 

 
Other Assets Contribution The annual amount of money contributed to the Other 

Assets. 

 
Other Assets Ending Value The balance of the Other Assets at the end of each 

year. 

 
Other Assets Net Growth The annual net growth of Other Assets. 

 
Owner Age The IRA owner’s age in each year. 

 
Owner L/E The owner’s life expectancy in each year. 
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P.V. of Future After-Tax 
Distributions 

The total distributions deferred over survivor’s life 
expectancy, starting in each year. 

 
Penalty on Pension Distributions The 10% penalty on Pension Fund distribution in each 

year. 

 
Penalty on Roth IRA Distribution The 10% penalty charged on Roth IRA distribution in 

each year. 

 
Penalty on Total Distributions The total 10% penalty on Pension Fund and Roth IRA 

distributions in each year. 

 
Pension Contribution The amount of money contributed to the Pension Fund 

in each year. 

 
Pension Deferral Term The deferral period available to survivors for taking 

money out of Pension Fund in each year. 
Pension Fund Begin Value The balance of the Pension Fund at the beginning of 

each year. 

 
Pension Fund Distributions to Gift 
Fund 

The amount taken from the Pension Fund for Donee-
Exclusion Gifting in each year. 

 
Pension Fund Distributions to 
Income 

The amount taken from the Pension Fund to pay 
Living Expenses in each year. 

 
Pension Fund Distributions to 
Insurance 

The amount taken from the Pension Fund for insurance 
premiums in each year. 

 
Pension Fund Distributions to 
Other Assets 

The amount taken from the Pension Fund for the Other 
Assets in each year. 

 
Pension Fund Distributions The distribution from the Pension Fund in each year. 
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Pension Fund Ending Value 
 

The balance of the Pension Fund at the end of each 
year. 

 
Pension Fund Growth The amount of Pension Fund growth in each year. 

 
Pension Fund Non-Deductible 
Balance 

 

Non-deductible balance at the end of each year. 

Pension Fund Subject to Income 
Tax 

The amount of the Pension Fund subject to income tax 
in each year. 

 
Pension Funds Begin Value The total qualified plan balance at the beginning of 

each year. 

 
Pension Funds Ending Value The total qualified plan balance at the end of each 

year. 
Pre-Insurance Net Assets The net value of assets to heirs if there was no life 

insurance, assuming owner is dead at end of each year. 

 
Pre-Tax Fund Growth The pre-tax growth of Other Assets in each year. 

 
Realized Growth The total amount of Other Assets growth realized in 

each year. 

 
Roth Deferral Term The deferral period available to survivors for taking 

money out of Roth IRA in each year. 

 
Roth IRA Begin Value The balance of the Roth IRA at the beginning of each 

year. 

 
Roth IRA Benef. Life Exp The life expectancy used to calculate Roth IRA 

minimum distributions in each year. 
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Roth IRA Contribution The amount of money contributed to the Roth IRA in 
each year. 

 
Roth IRA Conversion The amount of money converted to a Roth IRA in each 

year. 

 
Roth IRA Distribution Tax & 
Penalty 

The amount of income taxes and penalties caused by 
the Roth IRA distribution in each year. 

 
Roth IRA Distributions to Gift Fund The amount taken from the Roth IRA for Donee-

Exclusion Gifting in each year. 

 
Roth IRA Distributions to Income The amount taken from the Roth IRA to pay Living 

Expenses in each year. 

 
Roth IRA Distributions to Insurance The amount taken from the Roth IRA for insurance 

premiums in each year. 

 
Roth IRA Distributions to Other 
Assets 

The amount taken from the Roth IRA for the Other 
Assets in each year. 

 
Roth IRA Distributions The annual distribution from the Roth IRA. 

 
Roth IRA Ending Value The balance of the Roth IRA at the end of each year. 

 
Roth IRA Growth The amount of Roth IRA growth in each year. 

 
Secondary Benef. Age The age of the spouse’s beneficiary in each year. 

 
Spouse L/E The beneficiary’s life expectancy in each year. 

 
State Death Tax The state death tax (catch up tax) due if plan owner 

dies at end of each year. 
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Tax on Fund Growth The amount of tax on the growth of Other Assets in 
each year. 

 
Tax Rate At Death The income tax rate charged to Pension Fund if owner 

has died by end of each year. 

 
Tax Rate On Distributions The income tax rate on Pension Fund distributions in 

each year. 

 
Tax Rate On Growth The income tax rate used on growth of Other Assets in 

each year. 

 
Tax Saved by Pension Contribution The amount of tax savings generated by Pension Fund 

contributions in each year. 

 
Taxable Annuity The total amount of the taxable annuity in each year. 

 
Taxable Estate (Without Pension) The taxable estate if there were no Pension Fund in 

each year. 

 
Taxable Estate The total taxable estate in each year. 

 
Taxes at Death Paid from Gift Fund The death taxes paid from gift fund in each year. 

 
Taxes at Death Paid from 
Insurance 

The death taxes paid from insurance proceeds in each 
year. 

 
Taxes at Death Paid from Other 
Assets 

The total death taxes needed from Personal Fund in 
each year. 

 
Taxes at Death Paid from Pension 
Fund 

The total death taxes needed from Pension Fund in 
each year. 
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Taxes at Death Paid from Roth IRA The total death taxes needed from Roth IRA in each 
year. 

 
Total Conversion Tax Paid The amount of money spent to pay Roth IRA 

conversion taxes in each year. 

 
Total Funds Begin Value The total amount of funds at the beginning of each 

year. 
Total Funds Ending Value The total amount of funds at the end of each year. 

 
Total Tax on Distributions The total income tax on Pension Fund and Roth IRA 

distributions in each year. 

 
Total Taxes At Death The total federal and state death taxes due if plan 

owner dies at end of each year. If there is no deferral, 
this value includes the income tax on the Pension 
Fund. 

 
Unpaid Roth IRA Taxes The amount of income taxes due on the Roth IRA if 

the Roth IRA were liquidated at the end of each year. 

 
Unrealized Growth The total amount of Other Assets growth that is still 

not realized at the end of each year. 

 
Value of Funds Available at Death The total amount of cash given to heirs, assuming 

owner dies at end of each year. 

 
Year The year. 

 
Yearly After-Tax Distributions The net distribution from the Pension Fund and Roth 

IRA in each year. 
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Chapter 24 
Sample Cases 

Minimum Distributions Analysis 
If you’re looking to create a simple analysis that calculates required minimum 
distributions, this is the easiest way to do it. In this simple analysis, you will not enter any 
additional contributions, distributions, living expenses, conversions, or insurance 
premiums and proceeds. If you only want to see required minimum distributions, this 
other information is not required. 
 

Review the Input Assumptions. On the Edit menu, click Input Assumptions. 

Enter data in the top portion of the Main Inputs section. 

Then enter data for Alternative 1. 

Now, from the buttons on the left side of the window, click Reports (the bottom button). 
The Reports section appears. You’ll see four tabs at the top of the section. The 
Recommended tab will be highlighted. Click Minimum Distributions.  

Pre-59½ Distributions Analysis 
If you’re looking to create a simple analysis that calculates Pre-59½ Distributions, this is 
the easiest way to do it. In this simple analysis, you will not enter any additional 
contributions, distributions, living expenses, conversions, insurance premiums or 
proceeds, or tax information. If you’re only looking to see the Pre-59½ Distributions that 
plan owners need to avoid the 10% penalty, this other information is not required. 
 

From Quick Calcs menu, click Pre-59½ Distributions. The Pre-59 ½ Distributions 
Calculator appears. 

Next, enter the appropriate data in the Pre-59½ Distributions Calculator. As you enter 
data, the report below the calculator reflects the data changes. When you’ve completed 
your data entry, just view the report. If you’d like, you can print the report directly from 
the Pre-59½ Distributions Calculator.  

To include the Pre-59½ Distributions in the rest of the analysis, click Use Distrib. 

Roth IRA Conversions in the Current Year 
If you’re looking for a quick way to model three common Roth IRA scenarios, use Quick 
Conversion. Quick Conversion creates the three following scenarios: 
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• No Conversion to a Roth IRA 

• 100% Conversion to a Roth IRA in the current year—Taxes paid from the Other 
Assets fund 

• 100% Conversion to a Roth IRA in the current year—Taxes paid from the Roth 
IRA 

On the Quick Calc menu, click Quick Roth IRA Conversion. Follow the three steps on 
the screen. After completing Quick Conversion, the Comparison of Net After-Tax Assets 
report appears. 

Partial Conversions or Roth IRA Conversions in Different Years 
If you want to see the effects of multiple partial conversions, or you want to see the 
effects of conversions that occur in different years, you can use the following procedure: 
 

1. Enter the Input Assumptions. 

2. Enter data in the top portion of the Main Inputs section. 

3. Create your Alternatives. 

4. Click the Roth IRA button. The Roth IRA section appears. Click the 
Conversions tab and enter the conversion data. 

5. Click the Taxes button. The Taxes section appears. Select the method of 
calculating income tax. 

6. In the Taxes section, click the Conversion Tax tab. For each Alternative, select 
the fund from which conversion taxes will be paid. 

7. Click the Reports button. The Reports section appears. You’ll see four tabs at the 
top of the section. The Recommended tab will be highlighted. Click Comparison 
of Net After-Tax Assets. 

Note 
Using this procedure, you can certainly add data using other input sections of the program. 
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Chapter 25 
Getting Help 

 
If you need help, it’s easy to find. Click the question mark wherever it appears in the 
program and a Help topic appears for the window in which you are working. Also, use 
the Help menu and the program’s Help system. If you still need help, Brentmark provides 
technical support. 

Help Menu 
Use the Help menu on the Menu bar to access the Help system, learn how to use Help, or 
view information about this product and other Brentmark products.  

Help System 
The program provides a complete Help system, so you can get help whenever you need 
it. Just click the question mark that appears in the top right corner of every data entry 
section. Use the Help system’s table of contents to view Help topics by category or 
search the Help index for specific terms. 

Technical Support 
Technical Support is available by telephone, Fax, e-mail, or postal mail. If you have 
questions concerning program calculations, please have a list of your exact data entry 
values available when contacting us. 

Telephone 
Assistance by telephone is available Monday through Friday between 9:00 AM and 
6:00PM Eastern Standard Time at (407) 306-6160. 

Fax 
For assistance by fax, send your fax to (407) 306-6107. 

E-mail 
For assistance via e-mail, send your remarks to support@brentmark.com. 

Postal Mail 
For assistance by postal mail, write to: 
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Brentmark Software, Inc. 
3505 Lake Lynda Drive, Suite 212 
Orlando, FL 32817-8327 
 
In your correspondence, please include the following information: 

• The name of the person who registered the program. 

• A contact phone number. 

• The program name and version number. 

• Your system configuration. 

• A sample printout or description of the problem. 

• A list of any error messages that have appeared. 

Brentmark on the Web 
On the toolbar, click the globe graphic to access Brentmark’s website. 
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Chapter 26 
Articles 

 
The following copyrighted articles are  available exclusively on the Roth IRA Web Site: 
www.rothira.com. Reprint rights to the articles are freely granted. However, you must 
contact Brentmark first to receive an acknowledgement that will grant you reprint 
permission. We also need to know where you would like to republish the article. 

Five Financial Features that make Conversion to a Roth IRA So Desirable 
By Gregory Kolojeski 
There are five financial or economic features of a Roth IRA conversion that make it so 
attractive. The first three are the most important. If you can take full advantage of the first 
three, a conversion to a Roth IRA is usually a dunk shot. If you take significant advantage 
of the first two features, you will usually be ahead of the game (in many cases, this will 
be true even if you pay the conversion taxes from the IRA itself). If you take advantage 
of only one of the first three, you sometimes still come out ahead, but not always. In 
many cases, the presence of two of the first three features will even outweigh unfavorable 
income tax bracket situations. Despite what many articles suggest, income tax bracket 
considerations are usually of little importance if you can take advantage of the most 
favorable aspects of the Roth IRA.  

1. Post-70½ Deferral  
This is the tax-free growth and compounding that occurs after the point at which required 
minimum distributions would have been required under an ordinary IRA. This feature is 
tremendously important. If either the husband or wife survive past age 70½, the 
additional growth offered by withdrawing little or nothing for as long as possible adds 
tremendous value. 

2. After-Death Tax-Free Growth 
After the husband and wife die, the beneficiary will often be a child or even a grandchild. 
It will not be unusual for such a beneficiary to have a 30 to 60 year life expectancy for 
required distributions. The beneficiary takes such distributions tax-free with the balance 
of the plan growing tax-free in the meantime. This feature is tremendously valuable if 
one takes advantage of it. 

3. Gross-up of IRA Value by Paying Conversion Taxes from Other Assets 
If one has the financial ability to pay the conversion taxes (i.e., the income taxes) from 
other assets rather than from the IRA itself, you are effectively grossing up the value of 
the Roth IRA. You are effectively converting taxable assets to tax-free assets.   
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4. Four-Year Spreadout of Conversion Taxes for 1998 Conversions 
The value of this feature is generally overrated. Nonetheless, it is another piece with 
significant value even if it much less important than the previous three features. 

5. Prepayment of Income Tax Temporarily Lowers Federal Estate Tax 
When you pay the income tax on the conversion, you are effectively prepaying the 
income tax. In the short-run, this has the effect of lowering the federal estate tax. This 
effect ameliorates the hit of the income tax. Of course, in the long-run, the federal estate 
hit will go up since the Roth IRA will usually increase in value so much faster than an 
ordinary IRA that you will eventually have more assets that are taxable for estate tax 
purposes. But having more assets (for you or your beneficiary) is the goal here. Of 
course, this feature is only important to those who are subject to federal estate tax. 

Evaluating the Roth IRA: How much Deferral Can You Handle? 
By Gregory Kolojeski 
© 1997, 1998 Gregory Kolojeski 

The Name of the Game is Deferral 
For the Roth IRA, the name of the game is deferral. When all is said and done, what 
makes the Roth IRA such a wonderful wealth accumulation device is not just the tax-free 
nature of distributions. The power of this concept is the potential of additional decades of 
tax deferral beyond what is offered by an ordinary IRA. Even with a Roth IRA, the tax-
free growth will eventually end as required distributions convert the IRA assets back to 
property that generates taxable income.  
An ordinary IRA also offers considerable tax deferral. Ordinary IRAs also give you an 
upfront tax deduction as well. The price you pay is taxation at ordinary income rates 
when you are forced to start taking withdrawals starting in your age 70½ year. With a 
Roth IRA, you get no upfront tax deduction, but you do get tax-free withdrawals (after a 
five year period). If this were the only distinction, the analysis of the advantage (if any) 
of the Roth IRA would hinge largely on income tax rates. If income tax rates at the time 
of withdrawal were to be lower than at the time of contribution (or conversion), then the 
Roth IRA would generally be less attractive than an ordinary IRA would. (The word 
generally is used because there are exceptions even to that premise, especially when the 
federal estate tax is factored in.)  

No Minimum Distributions at Age 70½ 
What makes the Roth IRA so powerful is that minimum distribution rules do not kick in 
for the participant’s age 70½ year. There are no required minimum distributions until 
after the death of the participant. If he lives until age 85, there will have been an 
additional 15 years of tax deferral to that point. And there is potentially 15 more years of 
continuing contributions as well (if there was earned income during that period). Ignoring 
the possibility of a spousal beneficiary (or a spousal rollover) for the moment, let’s 
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assume that required minimum distributions now start the year following the participant’s 
year of death. Those distributions will be payable to the participant’s beneficiary using a 
single life term certain method. Let’s assume that the beneficiary is a child 25 years 
younger than the participant is. The beneficiary would now receive tax-free distributions 
over a 24-year period (based on a single life expectancy of 23.3 being decreased by 1 
each year). Even if the beneficiary died during that period, the distributions need not be 
accelerated, but could continue tax-free to the recipient for the full 24 years! 
 
From an economic viewpoint, what is happening when the participant’s beneficiary is 
forced to take minimum distributions (as in the preceding example for 24 years)? You 
can look at that distribution period as being the period in which tax-free growth is 
eventually converted to taxable growth. Each required minimum distribution is itself tax-
free, of course. If that required distribution is itself invested, that ensuing growth will 
then usually be taxable. Thus, distributions over 24 years could create a new fund whose 
growth is taxable. Yet, there is a lot of tax deferral being accomplished during the 24-
year period. This is on top of the tax deferral that occurred during the participant’s life.  

Spousal Rollover Increases Deferral Period 
Now, let’s assume that the participant dies at 85 with a surviving spouse as the designated 
beneficiary. Let’s assume she is age 80 at the time and now treats the IRA as hers (a 
spousal rollover of an inherited IRA). Under the spousal rollover rules, she now treats the 
Roth IRA as if it were originally hers. (Not only does the IRS’ Model Agreement clearly 
allow for spousal rollovers, it makes the spousal rollover the normal case.) As the owner 
of the IRA, she does not have to make any minimum distributions during her life. She can 
use this period from the original participant’s death to her death as another period of 
additional tax-free growth. If she lives to age 90, then we have another 10 years of 
potential tax deferral tacked on to the original participant’s.  

Two Components of Tax Deferral 
The extra deferral offered by a Roth IRA has two major components. The first is the post-
70½ deferral period that generally lasts until the death of the second-to-die of the 
husband and wife. Any evaluation of the Roth IRA should rightfully focus on this 
deferral. Of course, this deferral ends at death. As such, it is not guaranteed and would 
not be achieved in cases of early death. The second component of tax deferral offered by 
the Roth IRA is the tax-free growth of the Roth IRA assets during the single life 
expectancy period of the beneficiary, often a child. For there to be significant advantage 
to this second component, it is important that income taxes due to the conversion be paid 
from other assets than those in the IRAs. (Even if conversion taxes are paid from an IRA, 
the first component of tax deferral will still make the Roth IRA conversion the better 
alternative in many cases.) 

Tax-Free Growth May Continue After Death 
The after-death tax-free growth component can be an important issue in a Roth IRA 
analysis. In some cases, this future tax-free growth arguably makes the Roth IRA more 
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valuable than the ordinary IRA even the day after you convert. For example, let’s assume 
a death at age 50 with a child as the beneficiary who is 25 years younger. That 25-year 
old would have a life expectancy of 57.0 years. If he were not to withdraw the Roth IRA 
any faster than required, he would withdraw 1/56 of the balance when 26 years old, 1/55 
of the balance when 27 years old, etc. During all that time, the IRA balance would grow 
tax-free and distributions would be tax-free to the child. If the funds had been left in an 
ordinary IRA, the same deferral period would still apply. However, all the growth would 
be taxable as distributions are made from an ordinary IRA. If both IRAs have the same 
starting balances, the value of the after-death growth in the Roth IRA will be much higher 
than in an ordinary IRA.  
 
How can the ordinary IRA and Roth IRA have the same starting balance if conversion 
taxes must be paid? Clearly, if the conversion taxes reduce the value of the Roth IRA 
(either if paid directly from the Roth IRA or if some amounts are left in the ordinary IRA 
to pay the taxes) and income tax rates stay the same, there would be little difference due 
to the effect of the tax-free growth. Either way, the taxes would be equivalent. However, 
if the conversion taxes are paid from other assets, there can be a substantial difference. 
By paying the Roth conversion taxes from other assets, a larger balance is being left in 
the Roth IRA to grow tax-free. The value of this additional tax-free growth has no 
counterpart in an ordinary IRA. You have effectively grossed-up your IRA balance by 
changing the balance from a tax-deferred value to a tax-free value. The value of the 
additional tax-free growth this generates in the Roth IRA will generally substantially 
outweigh the opportunity costs. Opportunity costs refer to how the other assets would 
have grown if not used to pay the conversion tax. Such growth on those other assets 
would generally be taxable. By using other assets to pay the conversion taxes, you are 
essentially converting assets with taxable growth to assets with tax-free growth.  
Another potential deferral advantage from a Roth IRA is due to the four-year spreadout 
of additional taxable income when you do a conversion in 1998. However, that deferral 
may be offset in whole or part due to a higher income tax rate from being pushed into 
higher brackets during those four years. Then again, a conversion in a year after 1998 
might result in still higher average tax rates and would not get a four-year spreadout. 

Avoid Distributions as Long as Possible 
Of course, all or part of the tax deferral is for naught if the IRA owner or his beneficiary 
needs to take out the money earlier. The key is when will distributions be needed? If 
distributions from the Roth IRA can be avoided for as long as possible, you and your 
beneficiaries will come out much further ahead. What a Roth IRA offers is additional 
decades of possible tax deferral beyond that offered by an ordinary IRA. Paying the 
conversion taxes from other assets also offers the ability to effectively convert taxable 
assets to nontaxable assets as well. Those benefits are what make the Roth IRA so 
powerful. 
  
The Roth IRA, with its potential long period of tax-free growth and tax-free distributions 
may be thought of as the ultimate wealth accumulation device. It should be the last place 
from which you take distributions. Live on your taxable income and other assets. The 
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Roth IRA offers extra decades of tax-free growth followed by tax-free distributions. 
There is no better tax shelter than the Roth IRA 
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Chapter 27 
Useful Resources 

 
Often, we are asked about books and publications that might be useful in the areas of 
pension and Roth IRA planning. We find the following sources particularly helpful. 
 
Life and Death Planning for Retirement Benefits 4th edition, 2002. 
By Natalie Choate.  
$89.95 plus $7 shipping (add SC sales tax, if applicable). 
 
Pensworth 
415 Gallatin Circle 
Irmo, SC 29229 
1-800-694-7624 
FAX (803) 781-7868. 
 

Sy Goldberg’s Planning Analysis: Working with the 2002 IRS Final Distribution Rules.  
$49 PDF file or $59 printed copy. 
Available at www.brentmark.com/sy.htm 
 

 
The Pension Answer Book, 2003 edition 
By Stephan J. Krass. 
$199 plus tax and shipping. Stock #14739. 
 
Aspen Publishers 
7201 McKinney Circle 
Fredrick, MD 21704 
 
1-800-638-8437 
 
 
Roth IRA Book: An Investor’s Guide 
By Gobind Daryanani, Ph.D. 
$34.95 plus $5 shipping (add SC sales tax, if applicable). 
 
Pensworth 
415 Gallatin Circle 
Irmo, SC 29063 
 
1-800-694-7624 
FAX (803) 781-7868 
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For more useful information about these and other areas, visit the Brentmark Software 
website at www.brentmark.com, the Roth IRA website at www.rothira.com, or the Roth 
401(k) website at www.roth401k.com. These websites are weighted heavily with pension 
and tax planning information. 
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License Agreement 
 
This software is protected by both United States copyright law and international treaty provisions. You 
must treat this software just like a book, except that you may copy it onto a computer to be used and you 
may make archival copies of the software for the sole purpose of backing up our software and protecting 
your investment from loss.  You must also agree not to reverse engineer the software. 
 
By saying “just like a book,” Brentmark means, for example, that this software may be used by any number 
of people, and may be freely moved from one computer location to another, so long as there is no 
possibility of it being used at one location or on one computer while it is being used at another.  Just as a 
book cannot be read by two different people in two different places at the same time, neither can the 
software be used by two different people in two different places at the same time (unless, of course, 
Brentmark’s copyright is being violated).   
 
Limited Warranty 
Brentmark Software, Inc. warrants the physical diskette(s) and physical documentation enclosed herein to 
be free of defects in materials and workmanship for a period of 60 days from the purchase date.  If 
Brentmark receives notification within the warranty period of defects in materials or workmanship, and 
such notification is determined by Brentmark to be correct, Brentmark will replace the defective diskette(s) 
or documentation.   
 
The entire and exclusive liability and remedy for breach of this Limited Warranty shall be limited to 
replacement of defective diskette(s) or documentation and shall not include or extend to any claim for or 
right to recover any other damages, including but not limited to, loss of profit, data or use of the software, 
or special, incidental or consequential damages or other similar claims, even if Brentmark has been 
specifically advised of the possibility of such damages.  In no event will Brentmark’s liability for any 
damages to you or any other person ever exceed the lower of suggested list price or actual price paid for the 
license to use the software, regardless of any form of the claim.   
 
BRENTMARK SOFTWARE, INC. SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  Specifically, Brentmark makes 
no representation or warranty that the software is fit for any particular purpose and any implied warranty of 
merchantability is limited to the 60-day duration of the Limited Warranty covering the physical diskette(s) 
and physical documentation only (and not the software) and is otherwise expressly and specifically 
disclaimed.   
 
The limited warranty gives you specific legal rights; you may have others that may vary from state to state.  
Some states do not allow the exclusion of incidental or consequential damages, or the limitation on how 
long an implied warranty lasts, so some of the above may not apply to you.   
 
Governing Law and General Provisions 
The License Statement and Limited Warranty shall be construed, interpreted and governed by the laws of 
the State of Florida and any action hereunder shall be brought only in Florida.  If any provision is found 
void, invalid or unenforceable it will not affect the validity of the balance of this License and Limited 
Warranty that shall remain valid and enforceable according to its terms.  If any remedy hereunder is 
determined to have failed of its essential purpose, all limitations of liability and exclusion of damages set 
forth herein shall remain in full force and effect.  This License and Limited Warranty may only be modified 
in writing signed by you and a specifically authorized representative of Brentmark.  All rights not 
specifically granted in this statement are reserved by Brentmark.   
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